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Part 1	 Introduction 

The objective of Forest Service appraisals is to determine fair market value. There can be 
situations when the current Transaction Evidence Appraisal system (TEA) does not provide Base 
Period Prices that reflect a fair market value starting point for appraisals (see Appendix 
3). When those situations occur, then an alternative approach is needed. 

The purpose of this handbook is to explain one alternative approach.  It explains the data and 
recommended methods to prepare quarterly market adjusted Base Period Prices (ABPPs) for 
National Forest timber and explain how to use those ABPPs in preparing U.S. Forest Service 
Timber appraisals. 

This market based (MB) approach follows current quarterly end product prices and uses them to 
produce an estimate of market adjusted BPP for stumpage for the most recent quarter.  The 
market adjustment factor is the ratio of the most recent quarter’s end product price divided by the 
sale volume weighted average of the end product prices during the base period. The end product 
prices are prices for products that are made from the stumpage. For sawtimber and some 
nonsawtimber this includes lumber prices and for some nonsawtimber it includes a price index 
for wood pulp. 

The details of the initial development of the market-based approach for estimating BPP including 
our initial equation estimates and various test results are described in FPL-GTR-2421. There we 
presented the arguments for the species/product groupings for appraisal groups, observations 
about BPPs as an estimate of fair market value, and the choice of major appraisal zones.  Since 
the publication of the GTR we have altered our major appraisal zones in the west to follow FS 
regional boundaries except for the traditional Eastside/Westside division in R6. We have also 
simplified the computation and no longer use separate steps to compute an initial base period 
price using a markup equation and a market correction factor to give a final base period price. 

The approach considers markets for stumpage in 6 species and products groups – 2 species 
groups (hardwood and softwood) and 3 stumpage products (sawtimber, nonsawtimber, 
fuelwood) - although the number varies by appraisal zone. For example, there are no hardwood 
species groups in the western appraisal zones.  In practice the species for the fuelwood product is 
not distinguished leading to just five products. 

1 Haynes, Richard W.; Skog, Kenneth E., Aubuchon, Richard. 2016. A process to establish and use 
base period prices for National forest System transaction evidence timber appraisal. General 
Technical Report FPL-GTR-242. Madison, WI: U.S. Department of Agriculture, Forest Service, 
Forest Products Laboratory. 43 p. https://www.fs.usda.gov/treesearch/pubs/54605 
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We envision that the market-based approach can be used with the basic framework and steps 
used in the current transactions evidence appraisal (TEA) system with several differences.  

1. The process recognizes major appraisal zones (z1) and, within these zones, local appraisal 
zones with selected national forests (z2). The national forests in each major appraisal zone 
are shown in the Appendix 1. 

2. The first step is computation of a volume weighted average of stumpage sales values for a 
recent base period of 4 or more quarters - a base period price (BPP) - for each of potentially 5 
appraisal groups. The sales included in the averages are from a local appraisal zone z2. 

3. The second step is computation of a market correction factor F (a ratio) to update each BPP 
value from the base period to an adjusted base period price (ABPP) for the most recent 
quarter q.  The adjustment is determined by the change in end product price (e.g. lumber) 
from a base period average to the value in the most recent quarter available. The change to 
BPP is made by multiplying BPP by the ratio of most recent quarter end product price 
divided by the base period average end product price.  Note: the end product price series (e.g. 
a particular lumber price series) used to update BPP values are the same for all local 
appraisal zones (z2) within a given large appraisal zone (z1). 

4. The third step is to multiply each appraisal group’s BPP by its market correction factor F to 
give adjusted base period prices (ABPP). 

5. We advocate starting an appraisal with a volume weighted average of ABPP values across all 
appraisal groups where the weights are determined by the volume of each product group in 
the sale. This would be followed by applying volume weighted cost adjustments. Taking 
this approach emphasizes the need to consider how costs are apportioned between sawtimber 
and nonsawtimber products. If Indicated Advertised Rates are needed for each or selected 
appraisal group, then weighted average of ABPPs and weighted average costs would not be 
used. 

6. We streamlined the various quality adjustments, unusual adjustments, market adjustments 
and competition adjustments. 

7. Like many current appraisal processes, we prepare a current market adjustment to the BPP.  
This adjustment tailors the BPP to market conditions in the most recent quarter. 

8. We recognize the need for unusual adjustments to allow for unique circumstances associated 
with a sale.  

9. For a given sale, cost adjustments will be applied to the adjusted BPP to provide a Predicted 
Bid Rate.  There is uncertainty in the Predicted Bid Rate because our BPP includes the effect 
of estimated (uncertain) average base period costs and costs adjustments that are uncertain 
for each new sale. We propose to manage the risk of overestimating Predicted Bid Rate by 
applying a roll-back factor to estimate the Indicated Advertised Rate.  Guidance for 
establishing this roll-back factor will be discussed in a later section. 

The MB approach like the TEA approach requires identification of mill locations (appraisal 
points) that are available for processing timber from a sale into finished products.  Current 
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manual direction requires an appraisal point (to estimate haul costs) “where the manufacturing 
facility is capable of processing the end product that is being appraised”.  The market-based 
approach for both hardwood and softwood sawtimber explicitly relies on prices for finished and 
often grade stamped lumber products. These product prices are mostly composite prices that 
average prices for products of various grades and species commonly marketed together. 

The implication of this for MB sale appraisals is that sawtimber is assumed to be utilized for 
finished lumber or other graded products like piles or telephone poles.  In sales where potential 
purchasers are small mills that cut rough full sawn lumber (often for local markets or to be 
shipped elsewhere for remanufacture), we suggest the appraiser use either the nonsawtimber 
ABPP or make an "unusual adjustment" if they want to use the sawtimber ABPP. Without some 
type of adjustment, both TEA and MB systems will likely over-appraise these sales of relatively 
low value timber.  

The TOOLs 

Figure 1 indicates the data inputs, and calculation TOOLS used to estimate BPP, market 
correction factors and ABPP for each appraisal group.  The following is a brief overview of each 
tool. 

TOOL1 summarizes price data for timber end products from market reports (softwood lumber, 
hardwood lumber, and wood pulp) for recent past quarters in the base period, and up to the most 
recent quarter available. These end product prices are used in TOOL2 to compute market 
correction factors (F) for BPPs for any collection of forests (z2) within a major appraisal zone 
z12. 

TOOL2 computes the market correction factor F for each appraisal group in an appraisal zone 
z2, for a given current quarter, q, and base period using data from TOOL1. TOOL2 also uses 
data on individual timber sales volume and value (specially downloaded from the Forest Service 
Cut and Sold database) for each national forest in z2 to summarize sale volume and value by 5 
appraisal groups (or stumpage products) - softwood and hardwood sawtimber, softwood and 
hardwood nonsawtimber, and fuelwood for each of 4 or more past quarters. The volume and 
value data are used to compute base period prices (BPP) for appraisal zone z2. The end product 
price data from TOOL1 and volume data from TOOL2 are used to compute the market 
adjustment factors, F. Adjusted BPP (ABPP), for each appraisal group, is computed as the 
product of BPP and F. 

Sheet names in the Excel TOOL1 and TOOL2 workbooks are shown in italics below. 

2 Softwood lumber, low value hardwood lumber and wood pulp prices are averages for the three 
months in each quarter where the month’s prices are the observed price for the first weekly 
reported price each month. High value (grade) hardwood lumber prices are a species weighted 
average where the quarter’s price is the price observed for the first Friday of a quarter. 
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Figure 1. Process model for TOOL1 and TOOL2 

TOOL2 Input – Timber 
sale volume and value 
for sales from the Cut 

and Sold report 

TOOL2 
Computes base period 

average stumpage price (BPP) 
for each appraisal group in a 
given appraisal zone (z2) for 
for a base period of 4 or more 

quarters 

Computes market adjustment 
factor (F) for the current 

quarter using end product 
prices from TOOL1 

Computes adjusted base 
period price for the current 
quarter (F * BPP) for each 

appraisal group in z2 

TOOL1  Input  –  
End product  

prices  by  major  
appraisal  zone  

TOOL1 
Computes quarterly average 

End Product prices from 
monthly data and displays 
them by appraisal group 

within each major appraisal 
region (z1) 

7 



 

  

	 		 	 	 	 	 	
         

    
   

 
 

  
 

 

   

 
   
 

 
  

 
  

   
 

  
     

  

  

Part 2	 TOOL1	 - Updating End	 Product Market Prices 
The process of updating end product market prices starts with entering monthly data in the sheet 
“Market Prices by Month SFT HWD” for six composite softwood lumber prices from Random 
Lengths, one producer price index from the US Bureau of Labor Statistics database, and nineteen 
species prices from the Hardwood Market Report.  For each data series you need to scroll down 
the columns referenced watching for the correct date (always shown to the left). 

1.  Update Market Pulp price index Column N 
a. Data source: Producer Price Index Series WPU09110501 

https://alfred.stlouisfed.org/series?seid=WPU09110501. Current data can be obtained 
by rolling the cursor over the first bar graph in the PPI index report:  Producer Price 
Index by Commodity for Pulp, Paper, and Allied Products: Wood Pulp 
(WPU09110501). The Red bars are preliminary estimates and the blue bars are 
revised estimates.  Use the latest red bar but check to see if recent months have been 
revised. 

b. Historical Data to date can be downloaded by clicking DOWNLOAD. 
c. The Market pulp index is entered in column N and the monthly price is calculated in 

column P. 
2.  Update Softwood and Hardwood Monthly Prices 

a. Starting in column D, update six composite softwood lumber prices, for each month 
enter the price for the first week with a Thursday from Random Lengths Weekly 
Report – Table titled Lumber Composite Price Comparisons. Column J is computed 
from entered data.  

b. Starting in column S, update nineteen 4/4 1C lumber species prices, for the first 
Friday of each month from the Hardwood Market Report. There are three different 
hardwood price series as shown in Table 1. 
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Table 1.  List of species from the Hardwood Market Report used in each of the hardwood 
lumber market prices 

High Value, #1C 4/4 Appalachian 
Hardwoods 

Low Value, 
North 
Northern 
Hardwoods 

Low Value, South 
Southern Hardwoods 

Ash N. Aspen #1C 4/4 S. Sap Gum #1C 4/4 

Basswood N. Aspen #2A 4/4 Appalachian Yellow Poplar 
#1C 4/4 

Beech Cants-Green S. Pallet Cants-Green 
Birch S. Board-Road-Green 
Cherry 
Hickory 
Hard Maple-#1&2 
Soft Maple-SAP&BTR 
Red Oak 
White Oak 
Poplar 
Walnut 

The volume weighted #1C price (Column AE) is computed using weights3 from the 
“Assumptions_Est_Coefficients” worksheet.  The averages (Columns AK for the North and AQ 
for the South) for low value hardwoods are averages of selected species data. The hardwood 
lumber prices are repeated for convenience next to the softwood lumber prices in columns K, L, 
and M, 

After price data are entered, several steps are completed automatically to produce a table which 
contains end product prices (averaged by quarter) and allocated to each major appraisal zone (z1) 
and appraisal group (softwood and hardwood, sawtimber and non sawtimber). This final table is 
in the sheet “MKT prices by Zone and Quarter”.  For the first step the end product prices are 
averaged by quarter in sheet “MKT Prices by Quarter SFT HWD”.  For the second step the 
quarterly prices are allocated to each appraisal group in each major appraisal zone in sheet “MKT 
Prices by Zone and Quarter”. Table 2 shows how the end product prices are assigned to 
appraisal groups for each region (z1).  It also shows the source of price data for each end 
product. 

3  These weights represent the historic relative production of species reported in the Hardwood 
Market Report and were developed Bill Leopold at the Northern Research Station. 
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Table 2. Crosswalk from data sources and end product prices, to appraisal zones and 
appraisal Groups 

Data Source Product Price 
series 

Appraisal Zones Appraisal Group(s) 

Hardwood Market 
Report 

Appalachian 
Hardwoods 

R9, R8 Hardwood sawtimber 

Northern Low 
value Hardwoods 

R9 Low value Hardwood 
sawtimber 

Southern Low 
value Hardwoods 

R8 Low value Hardwood 
sawtimber 

Random Lengths 
(RL) Composites 
Quarterly data 

Coast (average of 
coast dry and 
Green DF) 

R6 Westside Softwood sawtimber 
& Softwood 
nonsawtimber 

Inland R1, R5, R6 Eastside Softwood sawtimber 
& Softwood 
nonsawtimber 

SP (Southern 
Pine) 

Southeast (R8), Midsouth 
(R8) & Mark Twain 
National Forest 

Softwood sawtimber 

West SPF R2, R3, R4 Softwood sawtimber 
& Softwood 
nonsawtimber 

East SPF Lake States (R9), NE (R9) Softwood sawtimber 
US BLS Producer 
Price Index for 
wood pulp 

Southeast (R8), Midsouth 
(R8) & Mark Twain 
National Forest, Lake 
States (R9), NE (R9) 

Softwood 
nonsawtimber and 
Hardwood 
nonsawtimber 
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Part 3 TOOL2	 - Computing Base	 Period	 Price, Market Adjustment
factor and Adjusted Base Period Price 

The method described here is simplified from an original method that began by preparing 
markup equations to predict an initial base period price for an appraisal group in a current quarter 
for a large appraisal zone z1.  The simplified method is equivalent to the original method but 
does not require estimation and use of markup equations (see Appendix 2). 

The simplified method begins with estimation of the Base Period Price (BPP), for a given 
appraisal group g, in a local appraisal zone (z2) as the volume weighted average of high bids for 
sales in the local zone over a base period of several recent quarters (Equation 1). We use a base 
period of 4 quarters, but it could be longer. The appraisal zone z2 could include all the national 
forests in large appraisal zone z1 or a subset of national forests or districts within z1. 

(1) ∑ ���(�2, �, �)���(�2, �, �) = 1
0
23 5 ∑1023 ���(�2, �, �) 

VAL(z2,g,i) is the total high bid value (from the Cut and Sold database) for stumpage in 
quarter i, for an appraisal group g, in appraisal zone z2 

VOL(z2,g,i) is the total volume of timber sold in quarter i, appraisal group g, in appraisal 
zone z2. 

b is the base period with n quarters 

i is the index for quarters in the base period 

A market adjustment factor (F) is computed to adjust the BPP from market conditions during the 
base period (the end product prices during the base period) to the market conditions during the 
most recent quarter being used (the end product price in the most recent quarter) (Equation 2).  
The denominator of Equation 2 gives the volume weighted average end product price where the 
volume weights – by quarter - are the appraisal group volumes sold in each quarter of the base 
period. The numerator is the end product price for the most recent quarter available for the 
current appraisal. 

(2)
��(�1, �, �)

�(�2, �, �, �) = 0 ∑123 ���(�2, �, �) ∗ ��(�1, �, �)5 0∑123 ���(�2, �, �) 

PP(z1,g,q  or  i  ) is the  end product price (from product price reports), for appraisal group g  
in appraisal zone z1, in quarter q or i.   

q is the most recent quarter for which PP values are available 

n is the number of quarters in the base period b 
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i is the index for quarters in the base period 

The base period price (BPP) is adjusted to market conditions during the most recent quarter q by 
multiplying by correction factor F (Equation 3). 

(3)   ABPP(z2,g,b,q) = F(z2,g,b,q) * BPP(z2,g,b) 

Choosing 	Appraisal	zone	z2 and	 Base period	 b 

The appraisal zone for a sale (z2) may be a major appraisal zone (z1) or it may be a sub zone 
within z1.  The sub zones should not include parts of 2 more major appraisal zones.  The sub 
zones may be combinations of national forests or combinations of national forest districts.  If 
they are combinations of districts, then data from the  Cut and Sold database needs to be obtained 
on volume and value of sales by district for each quarter in the base period. This data is needed 
to compute base period volumes and values used in Equations 1 and 2. 

The quarters in base period b should match the quarters used to compute average base period 
costs that are used to make cost adjustments for the appraisal.  

The choice of appraisal zone z2 and base period b determines the base period sales that will be 
used to compute Base Period Price (equation 1).  If the number of sales is small, a single sale 
with significant volume and either quite high or low costs, or quite high or low competition can 
skew the average high bid and over represent cost conditions relative to a longer-term average of 
cost conditions.  The number of high bids used to compute BPP (from the cut and sold database) 
should be known.  If the number of sales is low (about 8-10) then we recommend enlarging the 
appraisal zone (z2) and/or expanding the number or quarters in the base period. The larger 
number of sales is needed if sale high bids were quite variable. The smaller number of sales is 
needed if sale high bids are less variable. 

Tool	 2	 Overview 

Tool2 computes base period price - BPP(z2,g,b), market adjustment factor - F(z2,g,b), and 
adjusted base period price for a recent quarter q – ABPP(z2,g,b,q), for each appraisal group g in 
appraisal zone z2 for a given base period b. It also computes the BPP for fuelwood. 

Base Period Price - BPP(z2,g,b) 

Computation of BPP requires data on base period sales from the Forest Service Cut and Sold 
database.  Lines of data are needed on the volume and value of timber sold for each appraisal 
group g in the appraisal zone z2 for each quarter in the base period b. We used data from a recent 
4 quarter period from the Cut and Sold database. A pivot table is used to summarize volume and 
value from individual sales by appraisal group and quarter. (Step 11 below) 

If the appraisal zone z2 is a sub zone of z1 composed of national forests or districts, a filter is 
needed with the pivot table to select specific national forests or districts to be included.  To have 
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a filter box appear (where forests or districts can be selected) click on any shaded header in the 
pivot table to show PivotTable Tools Analyze (above the spreadsheet), then click on Insert 
Slicer.  Select Forest_name, or District_name to create the box with forests or districts to select. 
Select the forests or districts to be included in the appraisal sub zone. 

Market Adjustment Factor	 - F(z2,g,b,q) 

The end product prices – PP – for the numerator and denominator of Equation 2 are obtained 
from TOOL1 sheet “MKT Prices by Zone and Quarter”.  The denominator of F is the volume 
weighted average of end product prices during the base period. Note: There is no market 
adjustment factor for fuelwood. The fuelwood BPP is used as the starting point for an appraisal 
instead of an adjusted BPP. 

An	 Example TOOL2 Excel Workbook 

We show steps to compute BPP, F and ABPP for appraisal groups in a subzone of national 
forests in Forest Service Region 4 for a 4-quarter base period FY18.2-FY19.1 and a most recent 
quarter – FY19.4.  The z2 includes the following national forests: Ashley, Bridger-Teton, 
Caribou/Targhee, Dixie, Fishlake, Manti-Lasal, and Uinta-Wasatch-Cache. 

Following are steps to construct TOOL2 in an Excel workbook. See the Excel workbook 
TOOL2 Example for R4. 

Step 1- Determine the large appraisal zone z1 and the quarters in the base period (typically 4). 
For our example z1 is Forest Service Region 4 and the base period is FY18.2-FY19.1 Note that 
we include all sales data for all of zone z1 (R4) not just for the subzone forests. This allows for 
optional modification of the forests in zone z2. Also determine the current quarter for the market 
adjusted BPP.  We choose FY19.4. 

Step 2 – Collect data 
place in one or more Excel sheets of 

a new Excel workbook or add sheets to the TOOL2 example Excel workbook. See tabs FY2018 
and FY2019Q1. Data variables are shown in Table 3. 

on timber sales from the Cut and Sold database that includes all sales 
during the base period quarters for the appraisal zone z1 and 
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Table 3.  Timber sales data from the Cut and Sold database 

Variable Type (numbers are 
likely to be in text form) 

Example values 

REPORT_FY Number 2018 
REPORT_QUARTER Number 1, 2, 3, 4 
REGION_CODE Number 1, 2, 3, 4, 5, 6, 8, 9, 10 
REGION_NAME Text Intermountain Region 
FOREST_CODE Number 1, 2, 3, … 
FOREST_NAME Text Sawtooth National Forest 
DISTRICT_CODE Number 1, 2, 3, … 
DISTRICT_NAME Text Fairfield Ranger District 
SALE_NUMBER Number 17551 
SALE_NAME Text Mis Libby 
CONVERTIBLE_NONCONVERTIBLE Text C 
CONTRACT_SPECIES_CODE text or number A, 108, 180, AS, AF 
CONTRACT_SPECIES_DESCRIPTION Text Douglas-fir, Lodgepole Pine 
PRODUCT Number 1, 3, 6, 7, 8 … 
PRODUCT_DESCRIPTION Text Sawtimber, Non-Saw, Posts 

… 
STEWARDSHIP_INDICATOR text Y, N 
CONTRACT_FORM_TYPE text and number 6T, 6, 2, 3, 4T, … 
SOLD_VOLUME_CCF number 1132.5 
SOLD_VALUE number 1206.66 
BID_METHOD_DESCRIPTION Text Sealed Bid, Oral Auction … 

Step 3 – In our example sheets    FY2018  and FY2019Q1  have  a filter in row 1  and that filter is  
used in column C to  screen out   all regions except R4 (if needed).  In column P the filter     screens  
out  stewardship sales (code=Y).  When data is available indicating Good Neighbor Authority 
sales  they would be screened out also.  In column T the filter is used to  screen out  all types of 
sales except Sealed Bid and Oral Auction. We  combine the data  from sheets   FY2018  and 
FY2019Q1 in sheet  1- Base period sales. In sheet   1- Base period sales  we need to  convert  the 
sale volume and value variables in columns R and S  from text to numbers. Highlight a column 
to adjust. From the Excel top command line, Select Data > Text to Columns, then follow the   
steps. This conversion is needed to allow later Pivot table calculations.    

Step 4- The Excel workbook    TOOL2 Example for R4   has a sheet   Added Variables  which, in a  
future step will be added to sheet    1- Base Period Sales.   For any new spreadsheet for another 
appraisal zone and base period add the  Added  Variables  sheet  “as is” to the new spreadsheet (to  
retain formulas, column positions, and proper cell references).   

14 



 

  

         
   

  

        
       

        
       

 
      

 

         
      

     

      
      

 
  

 

         
     

     
  

  
       

  
        

     

       
    

     
   

    

Step 5- In sheet  Added Variables,  in columns AB and AC is a table that shows how  
Product_Description in the sales data set will be converted to a new variable – Product     
Component. Check to see if changes are needed   where Product   Descriptions are classified  as 
nonsawtimber.  

Step 6- Copy, from TOOL1, the sheet MKT Prices by Zone and Quarter to a sheet of the same 
name in TOOL2.  We will use these end product prices (PP) to compute market adjustment 
factors F. 

Step 7- Copy columns U to AH in sheet Added Variables to columns U to AH in sheet 1- Base 
period sales. Afterword, in sheet 1- Base Period Sales there should not be #N/A in columns U to 
AD for rows that have sales data. NOTE – sheet 1- Base period sales in the example Excel 
worksheet is set to allow 2000 rows of sales data.  If there are more rows, change the formulas in 
column AH to row values more than 2001 and extend the formulas in columns U, X, AA, AD 
and AH beyond 2001 rows. Note – A unique sale number is created in column U. It is a 
combination of the sale_number in col I, the forest_code in col E, and the Region_code in col C. 

Step 8- In sheet 1- Base Period Sales select columns A to U. Create a pivot table using those 
columns and place it in a new sheet by selecting Excel top line commands – Insert > Pivot table. 
In our example this pivot table is in 2- Pivot- Total Value by Sale. 

Step 9- In sheet 2- Pivot- Total Value by Sale, in the section PivotTable Fields, drag the variable 
Unique Sale number to the Row box. Drag the variable Sold Value to the Values box. The table 
created to the left will have a left column with a Unique Sale number for each sale and a right 
column with the total sale value for each sale in the data set. There is zero value for some sales. 
The Values box should show Sum of Sold_Value.  If not, click on small “i” symbol immediately 
to the right and select “sum”. 

Step 10- From sheet 2- Pivot- Total Value by Sale copy the values in columns A and B (not the 
header or “blank” line, Grand total line, or the first line with a zero sale ID) to sheet 1- Base 
period Sales columns AE and AF (under the headers). Column AG shows a value 1 if the total 
value for a sale in column AE is greater than or equal to $2000. Columns AE and AG serve as a 
look up table to indicate in column AH if the data row is part of a sale with total value greater 
than or equal to $2000 (value=1).  Create a filter in the first row of sheet 1- Base period sales and 
screen column AH to only keep rows with values of 1 (sales value is greater than or equal to 
$2000). Copy Columns A to AH from sheet 1- Base period Sales and paste in a new sheet as 
Values and Source Formatting.  Our new sheet is 3- Base Period Sales as Values. 

Step 11- In sheet 3- Base Period sales as Values select columns A to AH. Create a pivot table 
using those columns – from the Excel top command line select Insert > PivotTable. Place the 
pivot table in a new tab.  Our new sheet is 4- Pivot- Vol & Val by Prod_Qtr. In the new sheet, in 
the section PivotTable Fields, drag the variables shown in Table 4 to the Columns, Rows and 
Values Boxes. 
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Table 4. Pivot table variables to produce total sale value and volume by appraisal group, 
and fiscal year quarter 

Columns Species Code Index Match 
Product Component 

Rows APP_ZONE 
REPORT_FY 
REPORT_QUARTER 

Values SOLD_VOLUME_CCF 
SOLD_VALUE 

The Values box should show Sum of Sold_Volume_CCF and Sum of Sold_Value.  If not, click 
on small “i” symbol immediately to the right and select “sum”. 

Step 12- Remove unneeded values from the pivot table by 1) In cell B3 select the Column labels 
filter and deselect #N/A and blank, 2) In cell A6 select the Row labels filter and deselect #N/A 
and blank 3) When the PivotTable Fields are showing, select the excel top line command Design 
> Subtotals > Don’t show subtotals, and select Design > Grand Totals > Off for rows and 
columns. 

Step 13- When the PivotTable Fields are showing, insert a “Slicer” to select sales data from only 
selected national forest by selecting the excel top line command PivotTable Analyze > Insert 
Slicer > Forest_Name. In the Slicer box select the multi-select icon next to Forest_Name. Then 
select the national forests in zone z2 - Ashley, Bridger-Teton, Caribou/Targhee, Dixie, Fishlake, 
Manti-Lasal and Uinta-Wasatch-Cache. The pivot table now computes total volume and value by 
quarter for those forests. 

Step 14- In sheet 4- Pivot- Vol & Val by Prod_Qtr prepare a table of end product market prices 
for softwood sawtimber and softwood nonsawtimber by quarter for R4 by linking to values in 
sheet MKT Prices by Zone and Quarter. See the table in 4- Pivot- Vol & Val by Prod_Qtr. Title 
of the table is “R4 End Mkt Prices from Tool2 sheet "MKT Prices by zone and Quarter". Note: 
This table format in Example TOOL2 (cells E22:G33) could be copied and pasted to the new 
sheet as starting point.  Links to end product market prices would need to be made manually in 
each cell of the table. 

Step 15- In sheet 4- Pivot- Vol & Val by Prod_Qtr prepare a table which computes, for each 
appraisal group,  1) BPP for FY18.2-FY19.1,  2) Volume weighted end product prices for 
FY18.2-FY19.1, 3) Market correction factor F for quarter FY19.4,  4) the market adjusted BPP 
for FY19.4.  and 5) the volume weighted average fuelwood price using data from the pivot table. 
For softwood non sawtimber and sawtimber, the BPPs are $5.13 and 28.47 per CCF, 
respectively. The market adjustment factors for FY19.4 are 0.65 and 0.86, respectively. Even 
though the end use product prices used to adjust sawtimber and nonsawtimber are the same in 
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each past quarter, the adjustment factors differ because the quarterly sale volume weights on end 
product prices differ between sawtimber and nonsawtimber. The adjusted BPPs are 3.32 and 
24.44 per CCF. The fuelwood BPP is $9.92. These three stumpage prices would be the 
starting point for a timber appraisal in FY20.1 for forests in zone 2 of R4.  

Note: The table format in the Example TOOL2 for BPP, F and ABPP (cells K10:O18) could be 
copied and pasted as starting point.  Links to actual stumpage volumes, values and predicted 
prices would need to be made manually in cells of the table. The table would need to be 
expanded when hardwood stumpage values are included. 

Step 16- Copy sheet 4- Pivot- Vol & Val by Prod_Qtr to a new sheet. In our example see 5-Pivot 
Sale Cnt by prod and Qtr. In the new sheet we compute the number of sales used to compute the 
sawtimber, nonsawtimber, and fuelwood BPPS. Click on the blue header to make the PivotTable 
Fields appear. Remove the entries in the Values box (sum of sold value, sum of sold volume). 
Drag Region_Name to the values box (this is an arbitrary choice to produce a count of data lines 
in the pivot table for each quarter/product). Drag the variable Unique sale number to the bottom 
of the Rows box.  The pivot table will now contain counts of number of data lines (could be 
several per sale) used to compute the fuelwood, nonsawtimber and sawtimber values in the pivot 
table in sheet 4- Pivot- Vol & Val by Prod_Qtr.  To calculate the count of sales rather than count 
of data rows enter the count( ) function at the bottom of each product column in the pivot table 
(fuelwood, nonsawtimber, sawtimber).  In the count function include the range of cells above 
that cover the quarters in the base period.  In the example spreadsheet the count of sales are 10, 6, 
and 18 for fuelwood, nonsawtimber, and sawtimber, respectively. These counts are above the 
suggested minimums (8-10) for fuelwood and sawtimber and somewhat below for nonsawtimber. 

Part 4	 Roll-back factors 
This section provides recommendations on roll-back factor that are somewhat more specific when 
using the Market Based Base Period Price than are provided in FS Handbook 2409.18 chapter 
40. 

One purpose of a roll-back factor is to allow for variation in the possible competition for a sale 
with lower competition possibly resulting in lower high bid than the historic average predicted 
high bid. Another purpose is to avoid no bid by recognizing that there is uncertainty in appraisal 
prediction of high bid and uncertainty in markets and competition.  

A guideline associated with attaining these goals is to have the average weighted advertised rate 
for sales over a 4-quarter period (in an appraisal zone) fall in a range of 70% to 85% of the 
average weighted high bid for those sales.  FS Handbook 2409.18 chapter 40 states “An 
objective of TEA is to establish advertised rates where the the ratio of advertised rates to bid 
rates will be within the 70 to 85 percent range in competitive areas.  The performance range may 
exceed 85 percent in non-competitive areas.  This ratio is based on the previous 4 calendar 
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quarters and measured on a weighted volume basis (FSM 2422.1).  If the advertised rates exceed 
85 percent of bid rates in competitive areas, there is an increased tendency for Forests to receive 
no-bid sales.  When a Forest’s average advertised rates are less than 70 percent of bid rates, the 
appraisal is doing a poor job of estimating fair market value. 

Applying	 the roll-back	 factor 

If the predicted bid rate (the predicted high bid) is accurate and we apply a fixed roll-back 
percent to the predicted high bid, then we are increasing the likely bid premium by a fixed 
percent of predicted high bid for each sale.  If, as an alternative, we apply a fixed percent roll-
back to the Base Period Price or adjusted Base Period Price (before cost adjustments) then the 
predicted bid premium will vary as a percent of predicted high bid. With roll-back as a percent of 
BPP then the dollar value of roll-back could be a large percent reduction in predicted bid if costs 
are high resulting in much more room for low bidding. Conversely, if costs are low (additions to 
BPP) then the percent reduction in predicted bid will be low, with greater likelihood of no bid. 
We recommend applying the roll-back to predicted bid rate to result in a fixed percent predicted 
bid premium rather than applying it to BPP which can result in a varying percent of predicted bid 
premium. 

Roll-back if	a 	sale is	in 	a competitive	area 

FS Handbook 2409.18 chapter 40 gives an example of what may be considered a competitive 
area - “For example, define a competitive market area or appraisal zone as an appraisal zone 
where sales data show that bid premiums are greater than 5 percent of the advertised rate and 60 
percent of the volume receives at least a 5 percent bid premium.”  We recommend this or a 
similar definition to determine if a sale is in a competitive area. 

For sales in a competitive area - If we assume the estimate of our BPP and correction with cost 
adjustments results in an unbiased estimate of predicted bid (is accurate on average over many 
sales) then we could apply a roll-back between 15% and 30% to meet the guideline to have 
average advertised rate be 70% to 85% of average high bid over 4 quarters.  To avoid the risk of 
falling below the 70% target it seems prudent to limit roll-back to 25%. We recommend a default 
roll-back of 15% of the predicted bid rate. This recommendation assumes there is no or little 
volume in appraisal groups over the 4-quarter period that were deficit and were appraised at base 
rates. When sales have appraisal groups that were deficit are assigned base rates are included in 
computing the average advertised rate over a 4 quarter period and compared average high bid for 
the 4 quarters we assume it is possible and acceptable for the average advertised rate to exceed 
the 85% of the average high bid if roll-back were set at 15%. 
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Adjustments to the default 15% percent roll-back - There are several potential issues that would 
not warrant a change in roll-back. 

• Quality of timber differs notably from base period average – use a quality correction to 
the BPP 

• Operational conditions differ notably from base period average – modify stump to truck 
cost. 

• Market prices for end products have increased or decreased up to the prior quarter – the 
Market BPP takes into account region-wide changes in end product prices up through the 
prior quarter.  

• Anticipated change in end use markets over the contract period – use escalation 
procedure to change initial accepted high bid prices after the contract is awarded. 

A roll-back of more than 15% may be warranted if we have information suggesting our predicted 
rate will be biased high – for example if the sale is in a part of the local appraisal zone (z2) 
where mills/users make products of lower value from logs for a particular appraisal group than 
the local zone-wide (z2) average, or if cost adjustments for the appraisal are deviations from z1 
average costs (versus zone 2 average costs) and the average costs for local zone z2 are higher 
than for z1 then, after costs adjustments the predicted rate would be biased high. Conversely, 
if we have information suggesting our predicted bid rate is biased low, we could select a roll-
back of 10%. 

Roll-back if	a 	sale is	in 	a non-competitive area	 

As stated in in FS Handbook 2409.18 chapter 40 – “In noncompetitive markets, a roll-back 
factor of from 0 to 5 percent should be used to arrive at the indicated advertised rate. 

Part 5	 Preparing a 2400-17	 using Adjusted Base	 Period	 Prices,	Cost	
Adjustments and a	 Roll-Back Factor 
The pilot studies have used a spread sheet shown in Figure 2 that mimics the 2400-17 form.  It 
has four parts.  Values in the table are usually volume weighted averages (across both species 
and product groups) for costs and prices.  Sometimes there are volume weighted averages 
separately for sawtimber, nonsawtimber and fuelwood for softwoods and hardwoods depending 
on how different regions consider product groups. The form has been applied in Regions that 
have a history of selling mixed product sales (sawtimber, pulpwood, posts and poles, and 
commercial fuelwood) and others that sell sawtimber and all else sales.  In the former case there 
are sometimes differences between our form and current practice in the apportionment of costs 
across product groups (sawtimber, nonsawtimber fuelwood), while in the later the nonsawtimber/ 
and or biomass products removal and use may be treated as an additional cost center for 
sawtimber instead of an appraisal group (see item 2 g below). 
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Appraisal begins with estimates of a base period price for each of 5 appraisal groups – softwood 
and hardwood for each of sawtimber, nonsawtimber and fuelwood (hardwood and softwood 
combined). 

1. Establish an Adjusted Base Period Price for each appraisal group 

A Base Period Price (BPP) is calculated for sawtimber and nonsawtimber (softwood and 
hardwood) and fuelwood for a local appraisal zone z2 for a recent base period using TOOL2. 
These prices would be placed in the red colored cells P - R, row 6 in Figure 2. 

The BPP for each appraisal group is adjusted for recent market conditions (factor F) as computed 
in TOOL2 for the most recent quarter. The factors are entered in the red cells O – Q, row 10. The 
resulting market adjusted based prices (ABPP) are averaged across all appraisal groups and 
placed in cell J9. 

For TEA appraisals, a volume weighted base period price is also calculated using base period 
prices for all appraisal groups (placed in cell I9).  Our BPP and the TEA BPP should be the same 
if they are based on the same set of screened sales in the same base period.  The TEA approach 
may apply a market (or zone) adjustment in cell I10.  The TEA adjusted base period price is in 
cell I11. 

The market adjusted BPP for TEA is in cell I11 and for the MB approach, it is in cell J9. 

2. Establish Sale Cost Adjustments as differences from Average Base Period Costs (column I, 
rows 13 to 35) 

a) Stump to Truck 
b) Haul Costs 
c) Road Maintenance 
d) Environmental (sometimes called contractual) 
e) Temporary Development Costs 
f) Specified Road Costs ( for Region 5 only) 
g) [If nonsawtimber and/or biomass are always deficit for an area they should be set up as a     

cost center]  
In preparing the per ccf costs for multiproduct sales it is important to include costs to harvest all 
required trees.  The appropriate costs are the total costs for all trees not just the sawtimber 
proportion.  Even if small and cull trees will be treated as yarded unmerchantable material 
(YUM) their costs still need to be included.  In computing cost per ccf all trees should be 
included in the total volume and all tree removal costs should be included in the total costs. 

In preparing costs there may be different processing locations for different products/ volumes in 
the sale.  For example, sawtimber might be appraised to a sawmill location cutting dimension 
lumber while nonsawtimber or fuelwood could be appraised to the location of a fuelwood or 
local post and pole producer.  In this case haul costs per ccf would be volume weighted average 
haul cost to the two appraisal points. 
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3. Establish any unusual cost adjustment (cell I37) 

An unusual cost adjustment should rarely be used. It may be a quality adjustment to reflect 
exceptionally high- or low-quality material. Only some products may have an adjustment. 
Specified road costs are treated as an unusual cost adjustment except for Region 5 where they are 
treated as a cost center. 

4. Establish the Predicted Bid Rate = Adjusted BPP +/- Sale costs adjustments. +/- Unusual 
adjustment 

Costs adjustments are differences in sale specific costs from base period average costs. If 
nonsawtimber or fuelwood are always deficit appraisal groups they should be treated as cost 
centers. 

The Predicted Bid Rate for the TEA and MB appraisals are shown in cells I41 and J41, 
respectively. 

5. Compute Indicated Advertised Rate 

If the sale is in a competitive zone, there is open competition for the sale (e.g. sealed bid, oral 
auction) and the appraisal is above base rate then we suggest a 15% roll-back applied to the 
predicted bid rate with option to increase if there is exceptionally high uncertainty in cost factors 
or decrease if there is exceptionally low uncertainty in cost factors. If a sale is offered for bid in 
a non competitive zone a 0-5% rollback is appropriate. If the sale is not open to competition (e.g. 
direct, negotiated) then there would be no roll-back is appropriate as indicated in FS Handbook 
2409.18 chapter 40.  

Indicated Advertised Rates for TEA and MB appraisals are in cells I48 and J48, respectively. 
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  Figure 2 
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Appendix 1 Major Appraisal zones,	Regions,	 and National Forests
(as	 shown in the FY18 Cut & Sold Reports) 

(Some National Forests may be shown twice to match different spellings etc.) 
APPRAISAL ZONE (z1) REGION FOREST_NAMES 

0 10 Chugach National Forest 
0 10 Tongass National Forest 
1 1 Beaverhead/Deerlodge National Forest 
1 1 Bitterroot National Forest 
1 1 Idaho Panhandle National Forest 
1 1 Clearwater National Forest 
1 1 Custer National Forest 
1 1 Flathead National Forest 
1 1 Gallatin National Forest 
1 1 Custer Gallatin National Forest 
1 1 Helena National Forest 
1 1 Kootenai National Forest 
1 1 Lewis And Clark National Forest 
1 1 Lolo National Forest 
1 1 Nez Perce National Forest 
1 1 Nez Perce - Clearwater National Forest 
1 1 Nez Perce-Clearwater National Forest 
2 2 Bighorn National Forest 
2 2 Black Hills National Forest 
2 2 GrandMesa/Uncompahgre/Gunnison National 

Forest 
2 2 Medicine Bow-Routt National Forest 
2 2 Nebraska National Forest 
2 2 Rio Grande National Forest 
2 2 Arapaho/Roosevelt National Forest 
2 2 Pike-San Isabel National Forest 
2 2 San Juan National Forest 
2 2 Shoshone National Forest 
2 2 White River National Forest 
3 3 Apache/Sitgreaves National Forest 
3 3 Carson National Forest 
3 3 Cibola National Forest 
3 3 Coconino National Forest 
3 3 Coronado National Forest 
3 3 Gila National Forest 
3 3 Kaibab National Forest 
3 3 Lincoln National Forest 
3 3 Prescott National Forest 

23 



 

  

    
     
     
     
     
     
    
     
    
     
    
     
     
     
       
     
     
   
     
     
      
     
     
     
     
    
    
     
    
     
     
       
      
      
      
     
     
     
     
     
     
     
     

3 3 Santa Fe National Forest 
3 3 Tonto National Forest 
4 4 Ashley National Forest 
4 4 Boise National Forest 
4 4 Bridger-Teton National Forest 
4 4 Dixie National Forest 
4 4 Fishlake National Forest 
4 4 Manti-Lasal National Forest 
4 4 Payette National Forest 
4 4 Salmon-Challis National Forest 
4 4 Sawtooth National Forest 
4 4 Caribou/Targhee National Forest 
4 4 Uinta-Wasatch-Cache National Forest 
5 5 Angeles National Forest 
5 5 Humboldt & Toiy National Forest 
5 5 Cleveland National Forest 
5 5 Eldorado National Forest 
5 5 Inyo National Forest 
5 5 Klamath National Forest 
5 5 Lassen National Forest 
5 5 Los Padres National Forest 
5 5 Mendocino National Forest 
5 5 Modoc National Forest 
5 5 Six Rivers National Forest 
5 5 Plumas National Forest 
5 5 San Bernardino National Forest 
5 5 Sequoia National Forest 
5 5 Shasta-Trinity National Forest 
5 5 Sierra National Forest 
5 5 Stanislaus National Forest 
5 5 Tahoe National Forest 
5 5 Lake Tahoe Basin National Forest 
6 6 Gifford Pinchot National Forest 
6 6 Mt. Baker/Snoqualmie National Forest 
6 6 Mt. Hood National Forest 
6 6 Olympic National Forest 
6 6 Rogue River-Siskiyou National Forest 
6 6 Siuslaw National Forest 
6 6 Umpqua National Forest 
6 6 Willamette National Forest 
7 6 Deschutes National Forest 
7 6 Fremont-Winema National Forest 
7 6 Malheur National Forest 
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7 6 Ochoco National Forest 
7 6 Umatilla National Forest 
7 6 Wallowa-Whitman National Forest 
7 6 Okanogan-Wenatchee National Forest 
7 6 Colville National Forest 
8 8 NFS In Alabama National Forest 
8 8 Daniel Boone National Forest 
8 8 Chattahoochee/Oconee National Forest 
8 8 Cherokee National Forest 
8 8 NFS In Florida National Forest 
8 8 Kisatchie National Forest 
8 8 NFS In Mississippi National Forest 
8 8 NF Mississippi National Forest 
8 8 George Washington & Jefferson National Forest 
8 8 NFS in N. Carolina National Forest 
8 8 NF N. Carolina National Forest 
8 8 Francis Marion National Forest 
8 8 Francis Marion-Sumter National Forest 
8 8 Land Between The Lakes National Forest 
9 8 Ozark St. Francis National Forest 
9 8 NFS In Texas National Forest 
9 8 Ouachita National Forest 
9 9 Mark Twain National Forest 
10 9 Chippewa National Forest 
10 9 Huron Manistee National Forest 
10 9 Ottawa National Forest 
10 9 Superior National Forest 
10 9 Hiawatha National Forest 
10 9 Chequamegon/Nicolet National Forest 
11 9 Shawnee National Forest 
11 9 Hoosier National Forest 
11 9 Wayne National Forest 
11 9 Allegheny National Forest 
11 9 Monongahela National Forest 
11 9 Green Mountain National Forest 
11 9 White Mountain National Forest 
22 6 Columbia River Gorge National Scenic Area 

National Forest 
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Appendix 2	 – Estimation	 of Market Based	 Base	 Period	 Price	 by	 the	
Original Method	 and	 the	 Simplified	 method 

The Original Method 

The original method for estimating a market based base period price for Forest Service timber appraisals 
was described in the Forest Service General Technical Report FPL-GTR-2424. This Appendix explains 
how the simplified method is derived from, and is equivalent to, the original method 

The original method estimated an initial base period price for an appraisal group g, in a major appraisal 
zone z1, using a price markup equation. Each markup equation was estimated using a regression of 
quarterly average stumpage prices on end product prices such as lumber (Equation 1). The regressions 
used 20 quarters of data. Stumpage prices were from the Forest Service Cut and Sold database and end 
product prices were from Random Lengths, The Hardwood Market Report and the US Bureau of Labor 
Statistics.  

(1)   HB(z1,g,q)= C(z1,g)*PP(z1,g,q) + e(z1,g,q) 

HB(z1,g,q) is the average high bid (from the Cut and Sold database) for stumpage in an 
appraisal group g, in an appraisal zone z1, in a given quarter q , 

PP(z1,g,q) is the end product price (from product price reports), for appraisal group g in 
appraisal zone z1, in quarter q. 

C(z1,g) is a regression coefficient determined using 20 quarters of data for HB and PP. 

The markup equation is used to predict an initial base period price for the most recent quarter for 
which end product prices are available (Equation 2).  The initial base period prices (IBPP) are for 
a particular appraisal group g, in a major appraisal group z1 (such as a Forest Service Region), 
for the most recent quarter q. 

(2)  IBPP(z1,g,q) = C(z1,g)*PP(z1,g,q) 

IBPP(z1,g,q) is a predicted initial base period price (predicted high bid) for appraisal 
group g, in appraisal zone z1, and current quarter q. 

4 Haynes, Richard W.; Skog, Kenneth E., Aubuchon, Richard. 2016. A process to establish and use 
base period prices for National forest System transaction evidence timber appraisal. General 
Technical Report FPL-GTR-242. Madison, WI: U.S. Department of Agriculture, Forest Service, 
Forest Products Laboratory. 43 p. https://www.fs.usda.gov/treesearch/pubs/54605 

26 

https://www.fs.usda.gov/treesearch/pubs/54605


 

  

  
 

 
 
 

 

 

									  

 

 

 
 

 

    

  

This IBPP is for all forests within the major appraisal zone z1.  The IBPP estimate is based on 
the average influence of the end product market, as represented by the end product price (PP) 
and coefficient C. It also contains the influence of harvest and delivery costs for sales over a 20 
quarter period. 

For a subzone of national forests (z2) within z1, the recent effect of sales costs and end product 
markets may differ from the average over 20 quarters.  So we prepare a factor F1 to adjust the 
IBPP for recent differences in costs and market influence for the subzone in comparison to the 
major appraisal zone z1 and 20 quarter time period. 

The market adjustment factor F1 is the ratio of 1) actual volume weighted average high bids for 
sales in a recent base period (e.g 4 quarters) in subzone z2 divided by 2) volume weighted 
average predicted high bids from markup equations for zone z1 over the same quarters (Equation 
3). 

(3)									

∑1023 ���(�2, �, �)5∑1023 ���(�2, �, �)�1(�2, �, �) = 0 ∑123 ���(�2, �, �) ∗ �(�1, �) ∗ ��(�1, �, �)5 0∑123 ���(�2, �, �) 

F1(z2,g,b) = Volume weighted average high bids for sales in the base period /Volume   
weighted average equation predicted high bids during the base period.  

VAL(z2,g,i) is the total high bid value (from the Cut and Sold database) for stumpage  
sold in quarter i, for an appraisal group g, in appraisal zone z2  

VOL(z2,g,i) is the total volume of timber sold in quarter i, appraisal group g, in appraisal  
zone z2.  

z2 is either the same as zone z1 or a sub zone within z1. 

b = the quarters in base period b,  q= 1 to n. 

The market adjusted BPP (ABPP) for the stumpage in appraisal group g (softwood or hardwood 
sawtimber or nonsawtimber) , current quarter q, appraisal zone z2, and using base period b is 
given by 

(4) 
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The Simplified Method 

The simplified method eliminates the step to prepare markup equations to estimate the initial 
base period price (IBPP). 

Here is how the simplified method is derived from the original method.  The objective is to 
estimate ABPP(z2,g,q) in a simpler way. 

Substitute the full formula for F1(z2, g, b) from Equation 3 into Equation 4.  

(5)	 								

0∑123 ���(�2, �, �)5 0∑123 ���(�2, �, �)����(�2, �, �, �) = 0 ∗ ����(�1, �, �) ∑123 ���(�2, �, �) ∗ �(�1, �) ∗ ��(�1, �, �)5 0∑123 ���(�2, �, �) 

Substitute the full formula for IBPP(z1,g,q) from Equation 2 into Equation 5.  

(6)	 											

∑1023 ���(�2, �, �)5 0∑123 ���(�2, �, �)����(�2, �, �) = 0 ∗ C(z1, g) ∗ PP(z1, g, q) ∑123 ���(�2, �, �) ∗ �(�1, �) ∗ ��(�1, �, �)5 0∑123 ���(�2, �, �) 

In Equation 6, cancel markup equation coefficients C in numerator and denominator, move the 
variable PP from the right to the numerator of the ratio and move the current numerator of the 
ratio to the right were the variable PP had been. 

(7)	 									
0

����(�2, �, �) = 0 
PP(z1, g, q) 

∗ 
∑123 ���(�2, �, �)5∑0 ���(�2, �, �) ∑123 ���(�2, �, �) ∗ ��(�1, �, �) 1235 0∑123 ���(�2, �, �) 

In Equation 7 note that the term on the right is the calculation of the base period price for 
appraisal group g, in zone 2, for base period b. Calculating this base period price (BPP) is the 
first step in the simplified method described in Part 3. 

(8, Eqn 1 in Part 3)) 	 ∑0 ���(�2, �, �)���(�2, �, �) = 123 5 0 ∑123 ���(�2, �, �) 

In Equation 7 the term to the left is the market adjustment factor (F) and the second calculation 
step in the simplified method.  

(9, �qn 2 in Part 3)
��(�1, �, �)

�(�2, �, �, �) = 0 ∑ ���(�2, �, �) ∗ ��(�1, �, �)5123 
∑0 ���(�2, �, �)123 

For the simplified method we have 
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  (10,  Eqn 3 in Part  3))    ABPP(z2,g,b,q) = F(z2,g,b,q) * BPP(z2,g,b) 



 

  

	 	 	 	
	 	 	 	 	 			

 

    
      
   

   
  
  

 
  

  
  

  
   

 
   

 
  

 
 

  
  

  
  

    
  

  
  

   
 

  
  
   

 
 

 

Appendix 3	 – Conditions and	 Indications	 that Transaction	 Evidence	 
(TEA) Produced	 Base	 Period Prices May Be Questionable 

Conditions 

Any or a combination of items listed below may result in a data base that produces Base 
Period Prices (BPPs) not reflecting fair market value.  In those instances where TEA BPPs 
do not reflect fair market value, the Market-Based Approach should be considered. 

• Limited number of commercial sales in the data base 
o Small sales program or a period of time where few sales are offered 
o In some appraisal zones, the increase in Stewardship and Good Neighbor sales has 

reduced the number of commercial timber sales to a level below that which would 
give a reliable estimate of fair market value. 

• Questionable applicability of sales in the data base 
o Lack of competition 

• Particularly in combination with TEA’s application of a roll-back 
(competition) factor in setting the advertised rate -- Base Period Prices can 
substantially decline below fair market value over time; even when primary 
product prices are increasing. 

o Data base includes outlier sales (bid prices extremely high or low compared to normal 
expected prices) which skew Base Period Prices 

• Particularly in situations where the size of the sale has an excessive influence 
on the volume weighted average high bid  --- e.g. small number of sales and 
the outlier is a large sale compared to the others 

• Outdated appraisal zones 
o The unit appraising sales is in an appraisal zone that no longer accurately reflects that 

unit’s conditions (ground conditions, harvesting systems, sale costs, products offered, 
timber quality, etc.) 

• Transaction Evidence results are not tracking the market 
o For example – Base Period Prices are increasing while the market is in a decline. 

• Sales using Standard Rates do not reflect fair market value 
o Standard Rates are outdated 
o Standard Rates are being applied incorrectly 

• Automatically used when a full appraisal is more appropriate – sale too 
complex to justify Standard Rates 

• Data Base contains appraised deficit sales 
o Sales appraised as deficit and sold may indicate under-estimation of fair market value 
o Sales appraised as deficit and sold may indicate a market area where purchasers are 

compelled to buy at prices above fair market value because of supply/demand issues.  
If extensive enough, then over time Base Period Prices could reflect over-valuation. 
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Indications 

Sale results may indicate that Base Period Prices do not reflect fair market value 

• Notable fraction of the sales in the data base are sold at or close to advertised rates ---
advertised rates compared to high bid rates on a volume weighted basis are consistently 
greater than an 85% ratio (TEA ratio) 

o May indicate over-estimation of value. 
o See FSM 2422.1 

• Notable fraction of the sales in the data base have excessive bid premiums --- TEA ratio 
consistently falls below 70%. 

o May indicate under-estimation of value 
o See FSM 2422.1 

• High number of no-bids 
o May indicate over-estimation of value 

• Canvass purchasers 
• Consider sale conditions – did the appraisal accurately reflect them 

• Erratic sale results 
o Winning bids for apparently similar sales quite varied 

• May indicate appraisals do not account for sale conditions in all cases, thus 
not estimating fair market value correctly 

• May indicate that market conditions at time of sale are not being properly 
reflected 

• Sales described in the bullet statements above may be skewing Base Period 
Price estimates 

o Possibility of collusion among bidders 
• Consistent set of bidders with a predictable pattern of bidding 
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	Part 1. Introduction 
	The objective of Forest Service appraisals is to determine fair market value. There can be situations when the current Transaction Evidence Appraisal system (TEA) does not provide Base Period Prices that reflect a fair market value starting point for appraisals (see Appendix 3). When those situations occur, then an alternative approach is needed. 
	The purpose of this handbook is to explain one alternative approach.  It explains the data and recommended methods to prepare quarterly market adjusted Base Period Prices (ABPPs) for National Forest timber and explain how to use those ABPPs in preparing U.S. Forest Service Timber appraisals. 
	This market based (MB) approach follows current quarterly end product prices and uses them to produce an estimate of market adjusted BPP for stumpage for the most recent quarter.  The market adjustment factor is the ratio of the most recent quarter’s end product price divided by the sale volume weighted average of the end product prices during the base period. The end product prices are prices for products that are made from the stumpage. For sawtimber and some nonsawtimber this includes lumber prices and f
	The details of the initial development of the market-based approach for estimating BPP including our initial equation estimates and various test results are described in FPL-GTR-242. There we presented the arguments for the species/product groupings for appraisal groups, observations about BPPs as an estimate of fair market value, and the choice of major appraisal zones.  Since the publication of the GTR we have altered our major appraisal zones in the west to follow FS regional boundaries except for the tr
	1

	The approach considers markets for stumpage in 6 species and products groups – 2 species groups (hardwood and softwood) and 3 stumpage products (sawtimber, nonsawtimber, fuelwood) -although the number varies by appraisal zone. For example, there are no hardwood species groups in the western appraisal zones.  In practice the species for the fuelwood product is not distinguished leading to just five products. 
	We envision that the market-based approach can be used with the basic framework and steps used in the current transactions evidence appraisal (TEA) system with several differences.  
	1. 
	1. 
	1. 
	The process recognizes major appraisal zones (z1) and, within these zones, local appraisal zones with selected national forests (z2). The national forests in each major appraisal zone are shown in the Appendix 1. 

	2. 
	2. 
	The first step is computation of a volume weighted average of stumpage sales values for a recent base period of 4 or more quarters -a base period price (BPP) -for each of potentially 5 appraisal groups. The sales included in the averages are from a local appraisal zone z2. 

	3. 
	3. 
	The second step is computation of a market correction factor F (a ratio) to update each BPP value from the base period to an adjusted base period price (ABPP) for the most recent quarter q.  The adjustment is determined by the change in end product price (e.g. lumber) from a base period average to the value in the most recent quarter available. The change to BPP is made by multiplying BPP by the ratio of most recent quarter end product price divided by the base period average end product price.  Note: the e

	4. 
	4. 
	The third step is to multiply each appraisal group’s BPP by its market correction factor F to give adjusted base period prices (ABPP). 

	5. 
	5. 
	We advocate starting an appraisal with a volume weighted average of ABPP values across all appraisal groups where the weights are determined by the volume of each product group in the sale. This would be followed by applying volume weighted cost adjustments. Taking this approach emphasizes the need to consider how costs are apportioned between sawtimber and nonsawtimber products. If Indicated Advertised Rates are needed for each or selected appraisal group, then weighted average of ABPPs and weighted averag

	6. 
	6. 
	We streamlined the various quality adjustments, unusual adjustments, market adjustments and competition adjustments. 

	7. 
	7. 
	Like many current appraisal processes, we prepare a current market adjustment to the BPP.  This adjustment tailors the BPP to market conditions in the most recent quarter. 

	8. 
	8. 
	We recognize the need for unusual adjustments to allow for unique circumstances associated with a sale.  

	9. 
	9. 
	For a given sale, cost adjustments will be applied to the adjusted BPP to provide a Predicted Bid Rate.  There is uncertainty in the Predicted Bid Rate because our BPP includes the effect of estimated (uncertain) average base period costs and costs adjustments that are uncertain for each new sale. We propose to manage the risk of overestimating Predicted Bid Rate by applying a roll-back factor to estimate the Indicated Advertised Rate.  Guidance for establishing this roll-back factor will be discussed in a 


	The MB approach like the TEA approach requires identification of mill locations (appraisal points) that are available for processing timber from a sale into finished products.  Current 
	manual direction requires an appraisal point (to estimate haul costs) “where the manufacturing facility is capable of processing the end product that is being appraised”.  The market-based approach for both hardwood and softwood sawtimber explicitly relies on prices for finished and often grade stamped lumber products. These product prices are mostly composite prices that average prices for products of various grades and species commonly marketed together. 
	The implication of this for MB sale appraisals is that sawtimber is assumed to be utilized for finished lumber or other graded products like piles or telephone poles.  In sales where potential purchasers are small mills that cut rough full sawn lumber (often for local markets or to be shipped elsewhere for remanufacture), we suggest the appraiser use either the nonsawtimber ABPP or make an "unusual adjustment" if they want to use the sawtimber ABPP. Without some type of adjustment, both TEA and MB systems w
	The TOOLs 
	Figure 1 indicates the data inputs, and calculation TOOLS used to estimate BPP, market correction factors and ABPP for each appraisal group.  The following is a brief overview of each tool. 
	TOOL1 summarizes price data for timber end products from market reports (softwood lumber, hardwood lumber, and wood pulp) for recent past quarters in the base period, and up to the most recent quarter available. These end product prices are used in TOOL2 to compute market correction factors (F) for BPPs for any collection of forests (z2) within a major appraisal zone z1. 
	2

	TOOL2 computes the market correction factor F for each appraisal group in an appraisal zone z2, for a given current quarter, q, and base period using data from TOOL1. TOOL2 also uses data on individual timber sales volume and value (specially downloaded from the Forest Service Cut and Sold database) for each national forest in z2 to summarize sale volume and value by 5 appraisal groups (or stumpage products) -softwood and hardwood sawtimber, softwood and hardwood nonsawtimber, and fuelwood for each of 4 or 
	Sheet names in the Excel TOOL1 and TOOL2 workbooks are shown in italics below. 
	Haynes, Richard W.; Skog, Kenneth E., Aubuchon, Richard. 2016. A process to establish and use base period prices for National forest System transaction evidence timber appraisal. General Technical Report FPL-GTR-242. Madison, WI: U.S. Department of Agriculture, Forest Service, Forest Products Laboratory. 43 p. 
	Haynes, Richard W.; Skog, Kenneth E., Aubuchon, Richard. 2016. A process to establish and use base period prices for National forest System transaction evidence timber appraisal. General Technical Report FPL-GTR-242. Madison, WI: U.S. Department of Agriculture, Forest Service, Forest Products Laboratory. 43 p. 
	1 
	https://www.fs.usda.gov/treesearch/pubs/54605 


	Softwood lumber, low value hardwood lumber and wood pulp prices are averages for the three months in each quarter where the month’s prices are the observed price for the first weekly reported price each month. High value (grade) hardwood lumber prices are a species weighted average where the quarter’s price is the price observed for the first Friday of a quarter. 
	2 

	Figure 1. Process model for TOOL1 and TOOL2 
	Figure 1. Process model for TOOL1 and TOOL2 
	TOOL2 Input – Timber sale volume and value for sales from the Cut and Sold report 
	TOOL2 Computes base period average stumpage price (BPP) for each appraisal group in a given appraisalzone(z2)for for a base period of 4 or more quarters 
	Computes market adjustment factor (F) for the current quarter using end product prices from TOOL1 
	Computes adjusted base period price for the current quarter (F * BPP) for each appraisal group in z2 
	TOOL1  Input  –  End product  prices  by  major  appraisal  zone  
	TOOL1 Computes quarterly average End Product prices from monthly data and displays them by appraisal group within each majorappraisal region (z1) 
	Part 2. TOOL1. -Updating End. Product Market Prices 
	The process of updating end product market prices starts with entering monthly data in the sheet “Market Prices by Month SFT HWD” for six composite softwood lumber prices from Random Lengths, one producer price index from the US Bureau of Labor Statistics database, and nineteen species prices from the Hardwood Market Report.  For each data series you need to scroll down the columns referenced watching for the correct date (always shown to the left). 
	1.  
	1.  
	1.  
	Update Market Pulp price index Column N 
	a. 
	a. 
	a. 
	Data source: Producer Price Index Series WPU09110501 Current data can be obtained by rolling the cursor over the first bar graph in the PPI index report:  Producer Price Index by Commodity for Pulp, Paper, and Allied Products: Wood Pulp (WPU09110501). The Red bars are preliminary estimates and the blue bars are revised estimates.  Use the latest red bar but check to see if recent months have been revised. 
	. 
	https://alfred.stlouisfed.org/series?seid=WPU09110501



	b. 
	b. 
	Historical Data to date can be downloaded by clicking DOWNLOAD. 

	c. 
	c. 
	The Market pulp index is entered in column N and the monthly price is calculated in column P. 



	2.  
	2.  
	Update Softwood and Hardwood Monthly Prices 
	a. 
	a. 
	a. 
	Starting in column D, update six composite softwood lumber prices, for each month enter the price for the first week with a Thursday from Random Lengths Weekly Report – Table titled Lumber Composite Price Comparisons. Column J is computed from entered data.  

	b. 
	b. 
	Starting in column S, update nineteen 4/4 1C lumber species prices, for the first Friday of each month from the Hardwood Market Report. There are three different hardwood price series as shown in Table 1. 




	Table 1.  List of species from the Hardwood Market Report used in each of the hardwood lumber market prices 
	High Value, #1C 4/4 Appalachian Hardwoods 
	High Value, #1C 4/4 Appalachian Hardwoods 
	High Value, #1C 4/4 Appalachian Hardwoods 
	Low Value, North Northern Hardwoods 
	Low Value, South Southern Hardwoods 

	Ash 
	Ash 
	N. Aspen #1C 4/4 
	S. Sap Gum #1C 4/4 

	Basswood 
	Basswood 
	N. Aspen #2A 4/4 
	Appalachian Yellow Poplar #1C 4/4 

	Beech 
	Beech 
	Cants-Green 
	S. Pallet Cants-Green 

	Birch 
	Birch 
	S. Board-Road-Green 

	Cherry 
	Cherry 

	Hickory 
	Hickory 

	Hard Maple-#1&2 
	Hard Maple-#1&2 

	Soft Maple-SAP&BTR 
	Soft Maple-SAP&BTR 

	Red Oak 
	Red Oak 

	White Oak 
	White Oak 

	Poplar 
	Poplar 

	Walnut 
	Walnut 


	The volume weighted #1C price (Column AE) is computed using weightsfrom the “Assumptions_Est_Coefficients” worksheet.  The averages (Columns AK for the North and AQ for the South) for low value hardwoods are averages of selected species data. The hardwood lumber prices are repeated for convenience next to the softwood lumber prices in columns K, L, and M, 
	3 

	After price data are entered, several steps are completed automatically to produce a table which contains end product prices (averaged by quarter) and allocated to each major appraisal zone (z1) and appraisal group (softwood and hardwood, sawtimber and non sawtimber). This final table is in the sheet “MKT prices by Zone and Quarter”.  For the first step the end product prices are averaged by quarter in sheet “MKT Prices by Quarter SFT HWD”.  For the second step the quarterly prices are allocated to each app
	Table 2. Crosswalk from data sources and end product prices, to appraisal zones and appraisal Groups 
	Data Source 
	Data Source 
	Data Source 
	Product Price series 
	Appraisal Zones 
	Appraisal Group(s) 

	Hardwood Market Report 
	Hardwood Market Report 
	Appalachian Hardwoods 
	R9, R8 
	Hardwood sawtimber 

	Northern Low value Hardwoods 
	Northern Low value Hardwoods 
	R9 
	Low value Hardwood sawtimber 

	Southern Low value Hardwoods 
	Southern Low value Hardwoods 
	R8 
	Low value Hardwood sawtimber 

	Random Lengths (RL) Composites Quarterly data 
	Random Lengths (RL) Composites Quarterly data 
	Coast (average of coast dry and Green DF) 
	R6 Westside 
	Softwood sawtimber & Softwood nonsawtimber 

	Inland 
	Inland 
	R1, R5, R6 Eastside 
	Softwood sawtimber & Softwood nonsawtimber 

	SP (Southern Pine) 
	SP (Southern Pine) 
	Southeast (R8), Midsouth (R8) & Mark Twain National Forest 
	Softwood sawtimber 

	West SPF 
	West SPF 
	R2, R3, R4 
	Softwood sawtimber & Softwood nonsawtimber 

	East SPF 
	East SPF 
	Lake States (R9), NE (R9) 
	Softwood sawtimber 

	US BLS Producer Price Index for wood pulp 
	US BLS Producer Price Index for wood pulp 
	Southeast (R8), Midsouth (R8) & Mark Twain National Forest, Lake States (R9), NE (R9) 
	Softwood nonsawtimber and Hardwood nonsawtimber 


	Part 3 TOOL2. -Computing Base. Period. Price, Market Adjustmentfactor and Adjusted Base Period Price 
	The method described here is simplified from an original method that began by preparing markup equations to predict an initial base period price for an appraisal group in a current quarter for a large appraisal zone z1.  The simplified method is equivalent to the original method but does not require estimation and use of markup equations (see Appendix 2). 
	The simplified method begins with estimation of the Base Period Price (BPP), for a given appraisal group g, in a local appraisal zone (z2) as the volume weighted average of high bids for sales in the local zone over a base period of several recent quarters (Equation 1). We use a base period of 4 quarters, but it could be longer. The appraisal zone z2 could include all the national forests in large appraisal zone z1 or a subset of national forests or districts within z1. 
	(1)
	 ∑ (2, , )(2, , ) = 1023 5 ∑1023 (2, , ) 
	VAL(z2,g,i) 
	is the total high bid value (from the Cut and Sold database) for stumpage in 
	quarter i, for an appraisal group g, in appraisal zone z2 
	VOL(z2,g,i) 
	is the total volume of timber sold in quarter i, appraisal group g, in appraisal zone z2. 
	b is the base period with n quarters 
	i is the index for quarters in the base period 
	A market adjustment factor (F) is computed to adjust the BPP from market conditions during the base period (the end product prices during the base period) to the market conditions during the most recent quarter being used (the end product price in the most recent quarter) (Equation 2).  The denominator of Equation 2 gives the volume weighted average end product price where the volume weights – by quarter -are the appraisal group volumes sold in each quarter of the base period. The numerator is the end produ
	(2)
	(1, , )(2, , , ) = 0 ∑123 (2, , ) ∗ (1, , )50∑123 (2, , ) 
	PP(z1,g,q  or  i  ) is the  end product price (from product price reports), for appraisal group g  in appraisal zone z1, in quarter q or i.   
	q is the most recent quarter for which PP values are available 
	n is the number of quarters in the base period b 
	i is the index for quarters in the base period 
	The base period price (BPP) is adjusted to market conditions during the most recent quarter q by multiplying by correction factor F (Equation 3). 
	(3) 
	  ABPP(z2,g,b,q) = F(z2,g,b,q) * BPP(z2,g,b) 
	Choosing .Appraisal.zone.z2 and. Base period. b 
	The appraisal zone for a sale (z2) may be a major appraisal zone (z1) or it may be a sub zone within z1.  The sub zones should not include parts of 2 more major appraisal zones.  The sub zones may be combinations of national forests or combinations of national forest districts.  If they are combinations of districts, then data from the  Cut and Sold database needs to be obtained on volume and value of sales by district for each quarter in the base period. This data is needed to compute base period volumes a
	The quarters in base period b should match the quarters used to compute average base period costs that are used to make cost adjustments for the appraisal.  
	The quarters in base period b should match the quarters used to compute average base period costs that are used to make cost adjustments for the appraisal.  

	The choice of appraisal zone z2 and base period b determines the base period sales that will be used to compute Base Period Price (equation 1).  If the number of sales is small, a single sale with significant volume and either quite high or low costs, or quite high or low competition can skew the average high bid and over represent cost conditions relative to a longer-term average of cost conditions.  The number of high bids used to compute BPP (from the cut and sold database) should be known.  If the numbe
	Tool. 2. Overview 
	Tool2 computes base period price -BPP(z2,g,b), market adjustment factor -F(z2,g,b), and adjusted base period price for a recent quarter q – ABPP(z2,g,b,q), for each appraisal group g in appraisal zone z2 for a given base period b. It also computes the BPP for fuelwood. 
	Base Period Price -BPP(z2,g,b) 
	Computation of BPP requires data on base period sales from the Forest Service Cut and Sold database.  Lines of data are needed on the volume and value of timber sold for each appraisal group g in the appraisal zone z2 for each quarter in the base period b. We used data from a recent 4 quarter period from the Cut and Sold database. A pivot table is used to summarize volume and value from individual sales by appraisal group and quarter. (Step 11 below) 
	If the appraisal zone z2 is a sub zone of z1 composed of national forests or districts, a filter is needed with the pivot table to select specific national forests or districts to be included.  To have 
	If the appraisal zone z2 is a sub zone of z1 composed of national forests or districts, a filter is needed with the pivot table to select specific national forests or districts to be included.  To have 
	a filter box appear (where forests or districts can be selected) click on any shaded header in the pivot table to show PivotTable Tools Analyze (above the spreadsheet), then click on Insert Slicer.  Select Forest_name, or District_name to create the box with forests or districts to select. Select the forests or districts to be included in the appraisal sub zone. 

	Figure
	Market Adjustment Factor. -F(z2,g,b,q) 
	The end product prices – PP – for the numerator and denominator of Equation 2 are obtained from TOOL1 sheet “MKT Prices by Zone and Quarter”.  The denominator of F is the volume weighted average of end product prices during the base period. Note: There is no market adjustment factor for fuelwood. The fuelwood BPP is used as the starting point for an appraisal instead of an adjusted BPP. 
	An. Example TOOL2 Excel Workbook 
	We show steps to compute BPP, F and ABPP for appraisal groups in a subzone of national forests in Forest Service Region 4 for a 4-quarter base period FY18.2-FY19.1 and a most recent quarter – FY19.4.  The z2 includes the following national forests: Ashley, Bridger-Teton, Caribou/Targhee, Dixie, Fishlake, Manti-Lasal, and Uinta-Wasatch-Cache. 
	Following are steps to construct TOOL2 in an Excel workbook. See the Excel workbook TOOL2 Example for R4. 
	Step 1-
	Determine the large appraisal zone z1 and the quarters in the base period (typically 4). For our example z1 is Forest Service Region 4 and the base period is FY18.2-FY19.1 Note that we include all sales data for all of zone z1 (R4) not just for the subzone forests. This allows for optional modification of the forests in zone z2. Also determine the current quarter for the market adjusted BPP.  We choose FY19.4. 

	Step 2 – 
	Collect data place in one or more Excel sheets of a new Excel workbook or add sheets to the TOOL2 example Excel workbook. See tabs FY2018 and FY2019Q1. Data variables are shown in Table 3. on timber sales from the Cut and Sold database that includes all sales during the base period quarters for the appraisal zone z1 and 

	Table 3.  Timber sales data from the Cut and Sold database 
	Variable 
	Variable 
	Variable 
	Type (numbers are likely to be in text form) 
	Example values 

	REPORT_FY 
	REPORT_FY 
	Number 
	2018 

	REPORT_QUARTER 
	REPORT_QUARTER 
	Number 
	1, 2, 3, 4 

	REGION_CODE 
	REGION_CODE 
	Number 
	1, 2, 3, 4, 5, 6, 8, 9, 10 

	REGION_NAME 
	REGION_NAME 
	Text 
	Intermountain Region 

	FOREST_CODE 
	FOREST_CODE 
	Number 
	1, 2, 3, … 

	FOREST_NAME 
	FOREST_NAME 
	Text 
	Sawtooth National Forest 

	DISTRICT_CODE 
	DISTRICT_CODE 
	Number 
	1, 2, 3, … 

	DISTRICT_NAME 
	DISTRICT_NAME 
	Text 
	Fairfield Ranger District 

	SALE_NUMBER 
	SALE_NUMBER 
	Number 
	17551 

	SALE_NAME 
	SALE_NAME 
	Text 
	Mis Libby 

	CONVERTIBLE_NONCONVERTIBLE 
	CONVERTIBLE_NONCONVERTIBLE 
	Text 
	C 

	CONTRACT_SPECIES_CODE 
	CONTRACT_SPECIES_CODE 
	text or number 
	A, 108, 180, AS, AF 

	CONTRACT_SPECIES_DESCRIPTION 
	CONTRACT_SPECIES_DESCRIPTION 
	Text 
	Douglas-fir, Lodgepole Pine 

	PRODUCT 
	PRODUCT 
	Number 
	1, 3, 6, 7, 8 … 

	PRODUCT_DESCRIPTION 
	PRODUCT_DESCRIPTION 
	Text 
	Sawtimber, Non-Saw, Posts … 

	STEWARDSHIP_INDICATOR 
	STEWARDSHIP_INDICATOR 
	text 
	Y, N 

	CONTRACT_FORM_TYPE 
	CONTRACT_FORM_TYPE 
	text and number 
	6T, 6, 2, 3, 4T, … 

	SOLD_VOLUME_CCF 
	SOLD_VOLUME_CCF 
	number 
	1132.5 

	SOLD_VALUE 
	SOLD_VALUE 
	number 
	1206.66 

	BID_METHOD_DESCRIPTION 
	BID_METHOD_DESCRIPTION 
	Text 
	Sealed Bid, Oral Auction … 


	Step 3 – In our example sheets    FY2018  and FY2019Q1  have  a filter in row 1  and that filter is  used in column C to  screen out   all regions except R4 (if needed).  In column P the filter     screens  out  stewardship sales (code=Y).  When data is available indicating Good Neighbor Authority sales  they would be screened out also.  In column T the filter is used to  screen out  all types of sales except Sealed Bid and Oral Auction. We  combine the data  from sheets   FY2018  and FY2019Q1 in sheet  1- 
	Step 4- The Excel workbook    TOOL2 Example for R4   has a sheet   Added Variables  which, in a  future step will be added to sheet    1- Base Period Sales.   For any new spreadsheet for another appraisal zone and base period add the  Added  Variables  sheet  “as is” to the new spreadsheet (to  retain formulas, column positions, and proper cell references).   
	Step 5- In sheet  Added Variables,  in columns AB and AC is a table that shows how  Product_Description in the sales data set will be converted to a new variable – Product     Component. Check to see if changes are needed   where Product   Descriptions are classified  as nonsawtimber.  
	Step 6-
	Copy, from TOOL1, the sheet MKT Prices by Zone and Quarter to a sheet of the same name in TOOL2.  We will use these end product prices (PP) to compute market adjustment factors F. 

	Step 7-
	Copy columns U to AH in sheet Added Variables to columns U to AH in sheet 1-Base period sales. Afterword, in sheet 1-Base Period Sales there should not be #N/A in columns U to AD for rows that have sales data. NOTE – sheet 1-Base period sales in the example Excel worksheet is set to allow 2000 rows of sales data.  If there are more rows, change the formulas in column AH to row values more than 2001 and extend the formulas in columns U, X, AA, AD and AH beyond 2001 rows. Note – A unique sale number is create

	Step 8-
	In sheet 1-Base Period Sales select columns A to U. Create a pivot table using those columns and place it in a new sheet by selecting Excel top line commands – Insert > Pivot table. In our example this pivot table is in 2-Pivot-Total Value by Sale. 

	Step 9- 
	In sheet 2-Pivot-Total Value by Sale, in the section PivotTable Fields, drag the variable Unique Sale number to the Row box. Drag the variable Sold Value to the Values box. The table created to the left will have a left column with a Unique Sale number for each sale and a right column with the total sale value for each sale in the data set. There is zero value for some sales. The Values box should show Sum of Sold_Value.  If not, click on small “i” symbol immediately to the right and select “sum”. 
	Step 10-
	From sheet 2-Pivot-Total Value by Sale copy the values in columns A and B (not the header or “blank” line, Grand total line, or the first line with a zero sale ID) to sheet 1-Base period Sales columns AE and AF (under the headers). Column AG shows a value 1 if the total value for a sale in column AE is greater than or equal to $2000. Columns AE and AG serve as a look up table to indicate in column AH if the data row is part of a sale with total value greater than or equal to $2000 (value=1).  Create a filte

	Step 11-
	In sheet 3-Base Period sales as Values select columns A to AH. Create a pivot table using those columns – from the Excel top command line select Insert > PivotTable. Place the pivot table in a new tab.  Our new sheet is 4-Pivot-Vol & Val by Prod_Qtr. In the new sheet, in the section PivotTable Fields, drag the variables shown in Table 4 to the Columns, Rows and Values Boxes. 

	Table 4. Pivot table variables to produce total sale value and volume by appraisal group, and fiscal year quarter 
	Columns 
	Columns 
	Columns 
	Species Code Index Match Product Component 

	Rows 
	Rows 
	APP_ZONE REPORT_FY REPORT_QUARTER 

	Values 
	Values 
	SOLD_VOLUME_CCF SOLD_VALUE 


	The Values box should show Sum of Sold_Volume_CCF and Sum of Sold_Value.  If not, click on small “i” symbol immediately to the right and select “sum”. 
	Step 12-
	Remove unneeded values from the pivot table by 1) In cell B3 select the Column labels filter and deselect #N/A and blank, 2) In cell A6 select the Row labels filter and deselect #N/A and blank 3) When the PivotTable Fields are showing, select the excel top line command Design > Subtotals > Don’t show subtotals, and select Design > Grand Totals > Off for rows and columns. 

	Step 13- 
	When the PivotTable Fields are showing, insert a “Slicer” to select sales data from only selected national forest by selecting the excel top line command PivotTable Analyze > Insert Slicer > Forest_Name. In the Slicer box select the multi-select icon next to Forest_Name. Then select the national forests in zone z2 -Ashley, Bridger-Teton, Caribou/Targhee, Dixie, Fishlake, Manti-Lasal and Uinta-Wasatch-Cache. The pivot table now computes total volume and value by quarter for those forests. 
	Step 14- 
	In sheet 4-Pivot-Vol & Val by Prod_Qtr prepare a table of end product market prices for softwood sawtimber and softwood nonsawtimber by quarter for R4 by linking to values in sheet MKT Prices by Zone and Quarter. See the table in 4-Pivot-Vol & Val by Prod_Qtr. Title of the table is “R4 End Mkt Prices from Tool2 sheet "MKT Prices by zone and Quarter". Note: This table format in Example TOOL2 (cells E22:G33) could be copied and pasted to the new sheet as starting point.  Links to end product market prices wou
	Step 15- 
	Step 15- 
	In sheet 4-Pivot-Vol & Val by Prod_Qtr prepare a table which computes, for each appraisal group,  1) BPP for FY18.2-FY19.1,  2) Volume weighted end product prices for FY18.2-FY19.1, 3) Market correction factor F for quarter FY19.4,  4) the market adjusted BPP for FY19.4.  and 5) the volume weighted average fuelwood price using data from the pivot table. For softwood non sawtimber and sawtimber, the BPPs are $5.13 and 28.47 per CCF, respectively. The market adjustment factors for FY19.4 are 0.65 and 0.86, re
	each past quarter, the adjustment factors differ because the quarterly sale volume weights on end product prices differ between sawtimber and nonsawtimber. The adjusted BPPs are 3.32 and 24.44 per CCF. The fuelwood BPP is $9.92. These three stumpage prices would be the starting point for a timber appraisal in FY20.1 for forests in zone 2 of R4.  

	These weights represent the historic relative production of species reported in the Hardwood Market Report and were developed Bill Leopold at the Northern Research Station. 
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	Note: 
	Note: 
	The table format in the Example TOOL2 for BPP, F and ABPP (cells K10:O18) could be copied and pasted as starting point.  Links to actual stumpage volumes, values and predicted prices would need to be made manually in cells of the table. The table would need to be expanded when hardwood stumpage values are included. 
	Step 16-
	Copy sheet 4-Pivot-Vol & Val by Prod_Qtr to a new sheet. In our example see 5-Pivot Sale Cnt by prod and Qtr. In the new sheet we compute the number of sales used to compute the sawtimber, nonsawtimber, and fuelwood BPPS. Click on the blue header to make the PivotTable Fields appear. Remove the entries in the Values box (sum of sold value, sum of sold volume). Drag Region_Name to the values box (this is an arbitrary choice to produce a count of data lines in the pivot table for each quarter/product). Drag t

	Part 4. Roll-back factors 
	This section provides recommendations on roll-back factor that are somewhat more specific when using the Market Based Base Period Price than are provided in FS Handbook 2409.18 chapter 40. 
	One purpose of a roll-back factor is to allow for variation in the possible competition for a sale with lower competition possibly resulting in lower high bid than the historic average predicted high bid. Another purpose is to avoid no bid by recognizing that there is uncertainty in appraisal prediction of high bid and uncertainty in markets and competition.  
	A guideline associated with attaining these goals is to have the average weighted advertised rate for sales over a 4-quarter period (in an appraisal zone) fall in a range of 70% to 85% of the average weighted high bid for those sales.  FS Handbook 2409.18 chapter 40 states “An objective of TEA is to establish advertised rates where the the ratio of advertised rates to bid rates will be within the 70 to 85 percent range in competitive areas.  The performance range may exceed 85 percent in non-competitive are
	A guideline associated with attaining these goals is to have the average weighted advertised rate for sales over a 4-quarter period (in an appraisal zone) fall in a range of 70% to 85% of the average weighted high bid for those sales.  FS Handbook 2409.18 chapter 40 states “An objective of TEA is to establish advertised rates where the the ratio of advertised rates to bid rates will be within the 70 to 85 percent range in competitive areas.  The performance range may exceed 85 percent in non-competitive are
	quarters and measured on a weighted volume basis (FSM 2422.1).  If the advertised rates exceed 85 percent of bid rates in competitive areas, there is an increased tendency for Forests to receive no-bid sales.  When a Forest’s average advertised rates are less than 70 percent of bid rates, the appraisal is doing a poor job of estimating fair market value. 

	Applying. the roll-back. factor 
	back to the Base Period Price or adjusted Base Period Price (before cost adjustments) then the predicted bid premium will vary as a percent of predicted high bid. With roll-back as a percent of BPP then the dollar value of roll-back could be a large percent reduction in predicted bid if costs are high resulting in much more room for low bidding. Conversely, if costs are low (additions to BPP) then the percent reduction in predicted bid will be low, with greater likelihood of no bid. We recommend applying th
	If the predicted bid rate (the predicted high bid) is accurate and we apply a fixed roll-back percent to the predicted high bid, then we are increasing the likely bid premium by a fixed percent of predicted high bid for each sale.  If, as an alternative, we apply a fixed percent roll
	-

	Roll-back if.a .sale is.in .a competitive.area 
	FS Handbook 2409.18 chapter 40 gives an example of what may be considered a competitive area -“For example, define a competitive market area or appraisal zone as an appraisal zone where sales data show that bid premiums are greater than 5 percent of the advertised rate and 60 percent of the volume receives at least a 5 percent bid premium.”  We recommend this or a similar definition to determine if a sale is in a competitive area. 
	For sales in a competitive area -If we assume the estimate of our BPP and correction with cost adjustments results in an unbiased estimate of predicted bid (is accurate on average over many sales) then we could apply a roll-back between 15% and 30% to meet the guideline to have average advertised rate be 70% to 85% of average high bid over 4 quarters.  To avoid the risk of falling below the 70% target it seems prudent to limit roll-back to 25%. We recommend a default roll-back of 15% of the predicted bid ra
	Adjustments to the default 15% percent roll-back -There are several potential issues that would not warrant a change in roll-back. 
	• 
	• 
	• 
	Quality of timber differs notably from base period average – use a quality correction to the BPP 

	• 
	• 
	Operational conditions differ notably from base period average – modify stump to truck cost. 

	• 
	• 
	Market prices for end products have increased or decreased up to the prior quarter – the Market BPP takes into account region-wide changes in end product prices up through the prior quarter.  

	• 
	• 
	Anticipated change in end use markets over the contract period – use escalation procedure to change initial accepted high bid prices after the contract is awarded. 


	A roll-back of more than 15% may be warranted if we have information suggesting our predicted rate will be biased high – for example if the sale is in a part of the local appraisal zone (z2) where mills/users make products of lower value from logs for a particular appraisal group than the local zone-wide (z2) average, or if cost adjustments for the appraisal are deviations from z1 average costs (versus zone 2 average costs) and the average costs for local zone z2 are higher than for z1 then, after costs adj
	-

	Roll-back if.a .sale is.in .a non-competitive area. 
	As stated in in FS Handbook 2409.18 chapter 40 – “In noncompetitive markets, a roll-back factor of from 0 to 5 percent should be used to arrive at the indicated advertised rate. 
	Part 5. Preparing a 2400-17. using Adjusted Base. Period. Prices,.Cost.Adjustments and a. Roll-Back Factor 
	The pilot studies have used a spread sheet shown in Figure 2 that mimics the 2400-17 form.  It has four parts.  Values in the table are usually volume weighted averages (across both species and product groups) for costs and prices.  Sometimes there are volume weighted averages separately for sawtimber, nonsawtimber and fuelwood for softwoods and hardwoods depending on how different regions consider product groups. The form has been applied in Regions that have a history of selling mixed product sales (sawti
	Appraisal begins with estimates of a base period price for each of 5 appraisal groups – softwood and hardwood for each of sawtimber, nonsawtimber and fuelwood (hardwood and softwood combined). 
	1. 
	1. 
	1. 
	Establish an Adjusted Base Period Price for each appraisal group A Base Period Price (BPP) is calculated for sawtimber and nonsawtimber (softwood and hardwood) and fuelwood for a local appraisal zone z2 for a recent base period using TOOL2. These prices would be placed in the red colored cells P -R, row 6 in Figure 2. The BPP for each appraisal group is adjusted for recent market conditions (factor F) as computed in TOOL2 for the most recent quarter. The factors are entered in the red cells O – Q, row 10. T

	2. 
	2. 
	Establish Sale Cost Adjustments as differences from Average Base Period Costs (column I, rows 13 to 35) 
	a) 
	a) 
	a) 
	Stump to Truck 

	b) 
	b) 
	Haul Costs 

	c) 
	c) 
	Road Maintenance 

	d) 
	d) 
	Environmental (sometimes called contractual) 

	e) 
	e) 
	Temporary Development Costs 

	f) 
	f) 
	Specified Road Costs ( for Region 5 only) 

	g) 
	g) 
	[If nonsawtimber and/or biomass are always deficit for an area they should be set up as a     cost center]  


	In preparing the per ccf costs for multiproduct sales it is important to include costs to harvest all required trees.  The appropriate costs are the total costs for all trees not just the sawtimber proportion.  Even if small and cull trees will be treated as yarded unmerchantable material (YUM) their costs still need to be included.  In computing cost per ccf all trees should be included in the total volume and all tree removal costs should be included in the total costs. 
	In preparing costs there may be different processing locations for different products/ volumes in the sale.  For example, sawtimber might be appraised to a sawmill location cutting dimension lumber while nonsawtimber or fuelwood could be appraised to the location of a fuelwood or local post and pole producer.  In this case haul costs per ccf would be volume weighted average haul cost to the two appraisal points. 

	3. 
	3. 
	Establish any unusual cost adjustment (cell I37) An unusual cost adjustment should rarely be used. It may be a quality adjustment to reflect exceptionally high-or low-quality material. Only some products may have an adjustment. Specified road costs are treated as an unusual cost adjustment except for Region 5 where they are treated as a cost center. 

	4. 
	4. 
	Establish the Predicted Bid Rate = Adjusted BPP +/-Sale costs adjustments. +/-Unusual adjustment Costs adjustments are differences in sale specific costs from base period average costs. If nonsawtimber or fuelwood are always deficit appraisal groups they should be treated as cost centers. The Predicted Bid Rate for the TEA and MB appraisals are shown in cells I41 and J41, respectively. 

	5. 
	5. 
	Compute Indicated Advertised Rate If the sale is in a competitive zone, there is open competition for the sale (e.g. sealed bid, oral auction) and the appraisal is above base rate then we suggest a 15% roll-back applied to the predicted bid rate with option to increase if there is exceptionally high uncertainty in cost factors or decrease if there is exceptionally low uncertainty in cost factors. If a sale is offered for bid in a non competitive zone a 0-5% rollback is appropriate. If the sale is not open t


	Indicated Advertised Rates for TEA and MB appraisals are in cells I48 and J48, respectively. 
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	Appendix 1 Major Appraisal zones,.Regions,. and National Forests(as. shown in the FY18 Cut & Sold Reports) 
	Appendix 1 Major Appraisal zones,.Regions,. and National Forests(as. shown in the FY18 Cut & Sold Reports) 
	(Some National Forests may be shown twice to match different spellings etc.) 
	(Some National Forests may be shown twice to match different spellings etc.) 
	(Some National Forests may be shown twice to match different spellings etc.) 

	APPRAISAL ZONE (z1) 
	APPRAISAL ZONE (z1) 
	REGION 
	FOREST_NAMES 

	0 
	0 
	10 
	Chugach National Forest 

	0 
	0 
	10 
	Tongass National Forest 

	1 
	1 
	1 
	Beaverhead/Deerlodge National Forest 

	1 
	1 
	1 
	Bitterroot National Forest 

	1 
	1 
	1 
	Idaho Panhandle National Forest 

	1 
	1 
	1 
	Clearwater National Forest 

	1 
	1 
	1 
	Custer National Forest 

	1 
	1 
	1 
	Flathead National Forest 

	1 
	1 
	1 
	Gallatin National Forest 

	1 
	1 
	1 
	Custer Gallatin National Forest 

	1 
	1 
	1 
	Helena National Forest 

	1 
	1 
	1 
	Kootenai National Forest 

	1 
	1 
	1 
	Lewis And Clark National Forest 

	1 
	1 
	1 
	Lolo National Forest 

	1 
	1 
	1 
	Nez Perce National Forest 

	1 
	1 
	1 
	Nez Perce -Clearwater National Forest 

	1 
	1 
	1 
	Nez Perce-Clearwater National Forest 

	2 
	2 
	2 
	Bighorn National Forest 

	2 
	2 
	2 
	Black Hills National Forest 

	2 
	2 
	2 
	GrandMesa/Uncompahgre/Gunnison National Forest 

	2 
	2 
	2 
	Medicine Bow-Routt National Forest 

	2 
	2 
	2 
	Nebraska National Forest 

	2 
	2 
	2 
	Rio Grande National Forest 

	2 
	2 
	2 
	Arapaho/Roosevelt National Forest 

	2 
	2 
	2 
	Pike-San Isabel National Forest 

	2 
	2 
	2 
	San Juan National Forest 

	2 
	2 
	2 
	Shoshone National Forest 

	2 
	2 
	2 
	White River National Forest 

	3 
	3 
	3 
	Apache/Sitgreaves National Forest 

	3 
	3 
	3 
	Carson National Forest 

	3 
	3 
	3 
	Cibola National Forest 

	3 
	3 
	3 
	Coconino National Forest 

	3 
	3 
	3 
	Coronado National Forest 

	3 
	3 
	3 
	Gila National Forest 

	3 
	3 
	3 
	Kaibab National Forest 

	3 
	3 
	3 
	Lincoln National Forest 

	3 
	3 
	3 
	Prescott National Forest 

	3 
	3 
	3 
	Santa Fe National Forest 

	3 
	3 
	3 
	Tonto National Forest 

	4 
	4 
	4 
	Ashley National Forest 

	4 
	4 
	4 
	Boise National Forest 

	4 
	4 
	4 
	Bridger-Teton National Forest 

	4 
	4 
	4 
	Dixie National Forest 

	4 
	4 
	4 
	Fishlake National Forest 

	4 
	4 
	4 
	Manti-Lasal National Forest 

	4 
	4 
	4 
	Payette National Forest 

	4 
	4 
	4 
	Salmon-Challis National Forest 

	4 
	4 
	4 
	Sawtooth National Forest 

	4 
	4 
	4 
	Caribou/Targhee National Forest 

	4 
	4 
	4 
	Uinta-Wasatch-Cache National Forest 

	5 
	5 
	5 
	Angeles National Forest 

	5 
	5 
	5 
	Humboldt & Toiy National Forest 

	5 
	5 
	5 
	Cleveland National Forest 

	5 
	5 
	5 
	Eldorado National Forest 

	5 
	5 
	5 
	Inyo National Forest 

	5 
	5 
	5 
	Klamath National Forest 

	5 
	5 
	5 
	Lassen National Forest 

	5 
	5 
	5 
	Los Padres National Forest 

	5 
	5 
	5 
	Mendocino National Forest 

	5 
	5 
	5 
	Modoc National Forest 

	5 
	5 
	5 
	Six Rivers National Forest 

	5 
	5 
	5 
	Plumas National Forest 

	5 
	5 
	5 
	San Bernardino National Forest 

	5 
	5 
	5 
	Sequoia National Forest 

	5 
	5 
	5 
	Shasta-Trinity National Forest 

	5 
	5 
	5 
	Sierra National Forest 

	5 
	5 
	5 
	Stanislaus National Forest 

	5 
	5 
	5 
	Tahoe National Forest 

	5 
	5 
	5 
	Lake Tahoe Basin National Forest 

	6 
	6 
	6 
	Gifford Pinchot National Forest 

	6 
	6 
	6 
	Mt. Baker/Snoqualmie National Forest 

	6 
	6 
	6 
	Mt. Hood National Forest 

	6 
	6 
	6 
	Olympic National Forest 

	6 
	6 
	6 
	Rogue River-Siskiyou National Forest 

	6 
	6 
	6 
	Siuslaw National Forest 

	6 
	6 
	6 
	Umpqua National Forest 

	6 
	6 
	6 
	Willamette National Forest 

	7 
	7 
	6 
	Deschutes National Forest 

	7 
	7 
	6 
	Fremont-Winema National Forest 

	7 
	7 
	6 
	Malheur National Forest 

	7 
	7 
	6 
	Ochoco National Forest 

	7 
	7 
	6 
	Umatilla National Forest 

	7 
	7 
	6 
	Wallowa-Whitman National Forest 

	7 
	7 
	6 
	Okanogan-Wenatchee National Forest 

	7 
	7 
	6 
	Colville National Forest 

	8 
	8 
	8 
	NFS In Alabama National Forest 

	8 
	8 
	8 
	Daniel Boone National Forest 

	8 
	8 
	8 
	Chattahoochee/Oconee National Forest 

	8 
	8 
	8 
	Cherokee National Forest 

	8 
	8 
	8 
	NFS In Florida National Forest 

	8 
	8 
	8 
	Kisatchie National Forest 

	8 
	8 
	8 
	NFS In Mississippi National Forest 

	8 
	8 
	8 
	NF Mississippi National Forest 

	8 
	8 
	8 
	George Washington & Jefferson National Forest 

	8 
	8 
	8 
	NFS in N. Carolina National Forest 

	8 
	8 
	8 
	NF N. Carolina National Forest 

	8 
	8 
	8 
	Francis Marion National Forest 

	8 
	8 
	8 
	Francis Marion-Sumter National Forest 

	8 
	8 
	8 
	Land Between The Lakes National Forest 

	9 
	9 
	8 
	Ozark St. Francis National Forest 

	9 
	9 
	8 
	NFS In Texas National Forest 

	9 
	9 
	8 
	Ouachita National Forest 

	9 
	9 
	9 
	Mark Twain National Forest 

	10 
	10 
	9 
	Chippewa National Forest 

	10 
	10 
	9 
	Huron Manistee National Forest 

	10 
	10 
	9 
	Ottawa National Forest 

	10 
	10 
	9 
	Superior National Forest 

	10 
	10 
	9 
	Hiawatha National Forest 

	10 
	10 
	9 
	Chequamegon/Nicolet National Forest 

	11 
	11 
	9 
	Shawnee National Forest 

	11 
	11 
	9 
	Hoosier National Forest 

	11 
	11 
	9 
	Wayne National Forest 

	11 
	11 
	9 
	Allegheny National Forest 

	11 
	11 
	9 
	Monongahela National Forest 

	11 
	11 
	9 
	Green Mountain National Forest 

	11 
	11 
	9 
	White Mountain National Forest 

	22 
	22 
	6 
	Columbia River Gorge National Scenic Area National Forest 
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	Appendix 2. – Estimation. of Market Based. Base. Period. Price. by. the.Original Method. and. the. Simplified. method 
	The Original Method 
	The Original Method 
	The original method for estimating a market based base period price for Forest Service timber appraisals was described in the Forest Service General Technical Report FPL-GTR-242. This Appendix explains how the simplified method is derived from, and is equivalent to, the original method 
	4

	The original method estimated an initial base period price for an appraisal group g, in a major appraisal zone z1, using a price markup equation. Each markup equation was estimated using a regression of quarterly average stumpage prices on end product prices such as lumber (Equation 1). The regressions used 20 quarters of data. Stumpage prices were from the Forest Service Cut and Sold database and end product prices were from Random Lengths, The Hardwood Market Report and the US Bureau of Labor Statistics. 
	(1) 
	  HB(z1,g,q)= C(z1,g)*PP(z1,g,q) + e(z1,g,q) 
	HB(z1,g,q) is the average high bid (from the Cut and Sold database) for stumpage in an appraisal group g, in an appraisal zone z1, in a given quarter q , 
	PP(z1,g,q) is the end product price (from product price reports), for appraisal group g in appraisal zone z1, in quarter q. 
	C(z1,g) is a regression coefficient determined using 20 quarters of data for HB and PP. 
	The markup equation is used to predict an initial base period price for the most recent quarter for which end product prices are available (Equation 2).  The initial base period prices (IBPP) are for a particular appraisal group g, in a major appraisal group z1 (such as a Forest Service Region), for the most recent quarter q. 
	(2) 
	 IBPP(z1,g,q) = C(z1,g)*PP(z1,g,q) 
	IBPP(z1,g,q) is a predicted initial base period price (predicted high bid) for appraisal group g, in appraisal zone z1, and current quarter q. 
	This IBPP is for all forests within the major appraisal zone z1.  The IBPP estimate is based on the average influence of the end product market, as represented by the end product price (PP) and coefficient C. It also contains the influence of harvest and delivery costs for sales over a 20 quarter period. 
	For a subzone of national forests (z2) within z1, the recent effect of sales costs and end product markets may differ from the average over 20 quarters.  So we prepare a factor F1 to adjust the IBPP for recent differences in costs and market influence for the subzone in comparison to the major appraisal zone z1 and 20 quarter time period. 
	The market adjustment factor F1 is the ratio of 1) actual volume weighted average high bids for sales in a recent base period (e.g 4 quarters) in subzone z2 divided by 2) volume weighted average predicted high bids from markup equations for zone z1 over the same quarters (Equation 3). 
	(3)
	.........∑1023 (2, , )5∑1023 (2, , )1(2, , ) = 0 ∑123 (2, , ) ∗ (1, ) ∗ (1, , )50∑123 (2, , ) 
	F1(z2,g,b) = Volume weighted average high bids for sales in the base period /Volume   weighted average equation predicted high bids during the base period.  
	VAL(z2,g,i) is the total high bid value (from the Cut and Sold database) for stumpage  sold in quarter i, for an appraisal group g, in appraisal zone z2  
	VOL(z2,g,i) is the total volume of timber sold in quarter i, appraisal group g, in appraisal  zone z2.  
	z2 is either the same as zone z1 or a sub zone within z1. 
	b = the quarters in base period b,  q= 1 to n. 
	The market adjusted BPP (ABPP) for the stumpage in appraisal group g (softwood or hardwood sawtimber or nonsawtimber) , current quarter q, appraisal zone z2, and using base period b is given by 
	(4) 
	Haynes, Richard W.; Skog, Kenneth E., Aubuchon, Richard. 2016. A process to establish and use base period prices for National forest System transaction evidence timber appraisal. General Technical Report FPL-GTR-242. Madison, WI: U.S. Department of Agriculture, Forest Service, Forest Products Laboratory. 43 p. 
	4 
	https://www.fs.usda.gov/treesearch/pubs/54605 


	 ABPP(z2,g,b,q) = F1(z2,g,b) * IBPP(z1,g,q) 
	 ABPP(z2,g,b,q) = F1(z2,g,b) * IBPP(z1,g,q) 
	The Simplified Method 
	The simplified method eliminates the step to prepare markup equations to estimate the initial base period price (IBPP). 
	Here is how the simplified method is derived from the original method.  The objective is to estimate ABPP(z2,g,q) in a simpler way. 
	Substitute the full formula for F1(z2, g, b) from Equation 3 into Equation 4.  
	(5)
	.........0∑123 (2, , )5 0∑123 (2, , )(2, , , ) = 0 ∗ (1, , ) ∑123 (2, , ) ∗ (1, ) ∗ (1, , )50∑123 (2, , ) 
	Substitute the full formula for IBPP(z1,g,q) from Equation 2 into Equation 5.  
	(6)
	............∑1023 (2, , )50∑123 (2, , )(2, , ) = 0 ∗ C(z1, g) ∗ PP(z1, g, q) ∑123 (2, , ) ∗ (1, ) ∗ (1, , )5 0∑123 (2, , ) 
	In Equation 6, cancel markup equation coefficients C in numerator and denominator, move the variable PP from the right to the numerator of the ratio and move the current numerator of the ratio to the right were the variable PP had been. 
	(7)
	..........0(2, , ) = 0 PP(z1, g, q) ∗ ∑123 (2, , )5∑0 (2, , ) ∑123 (2, , ) ∗ (1, , ) 12350∑123 (2, , ) 
	In Equation 7 note that the term on the right is the calculation of the base period price for appraisal group g, in zone 2, for base period b. Calculating this base period price (BPP) is the first step in the simplified method described in Part 3. 
	(8, Eqn 1 in Part 3)) 
	. ∑0 (2, , )(2, , ) = 123 5 0 ∑123 (2, , ) 
	In Equation 7 the term to the left is the market adjustment factor (F) and the second calculation step in the simplified method.  
	(9, qn 2 in Part 3)
	(1, , )(2, , , ) = 0 ∑ (2, , ) ∗ (1, , )5123 ∑0 (2, , )123 
	For the simplified method we have 


	  (10,  Eqn 3 in Part  3))  
	  (10,  Eqn 3 in Part  3))  
	  ABPP(z2,g,b,q) = F(z2,g,b,q) * BPP(z2,g,b) 
	Appendix 3. – Conditions and. Indications. that Transaction. Evidence. (TEA) Produced. Base. Period Prices May Be Questionable 
	Conditions 
	Conditions 
	Any or a combination of items listed below may result in a data base that produces Base Period Prices (BPPs) not reflecting fair market value.  In those instances where TEA BPPs do not reflect fair market value, the Market-Based Approach should be considered. 
	• 
	• 
	• 
	• 
	Limited number of commercial sales in the data base 

	o 
	o 
	o 
	Small sales program or a period of time where few sales are offered 

	o 
	o 
	In some appraisal zones, the increase in Stewardship and Good Neighbor sales has reduced the number of commercial timber sales to a level below that which would give a reliable estimate of fair market value. 



	• 
	• 
	• 
	Questionable applicability of sales in the data base 

	o 
	o 
	o 
	o 
	Lack of competition 

	Particularly in combination with TEA’s application of a roll-back (competition) factor in setting the advertised rate --Base Period Prices can substantially decline below fair market value over time; even when primary product prices are increasing. 
	•


	o 
	o 
	Data base includes outlier sales (bid prices extremely high or low compared to normal expected prices) which skew Base Period Prices 


	Particularly in situations where the size of the sale has an excessive influence on the volume weighted average high bid  ---e.g. small number of sales and the outlier is a large sale compared to the others 
	•


	• 
	• 
	• 
	Outdated appraisal zones 

	o The unit appraising sales is in an appraisal zone that no longer accurately reflects that unit’s conditions (ground conditions, harvesting systems, sale costs, products offered, timber quality, etc.) 

	• 
	• 
	• 
	Transaction Evidence results are not tracking the market 

	o For example – Base Period Prices are increasing while the market is in a decline. 

	• 
	• 
	• 
	Sales using Standard Rates do not reflect fair market value 

	o 
	o 
	o 
	Standard Rates are outdated 

	o 
	o 
	Standard Rates are being applied incorrectly 


	Automatically used when a full appraisal is more appropriate – sale too complex to justify Standard Rates 
	•


	• 
	• 
	• 
	Data Base contains appraised deficit sales 

	o 
	o 
	o 
	Sales appraised as deficit and sold may indicate under-estimation of fair market value 

	o 
	o 
	Sales appraised as deficit and sold may indicate a market area where purchasers are compelled to buy at prices above fair market value because of supply/demand issues.  If extensive enough, then over time Base Period Prices could reflect over-valuation. 




	Indications 

	Sale results may indicate that Base Period Prices do not reflect fair market value 
	Sale results may indicate that Base Period Prices do not reflect fair market value 
	• 
	• 
	• 
	• 
	Notable fraction of the sales in the data base are sold at or close to advertised rates --advertised rates compared to high bid rates on a volume weighted basis are consistently greater than an 85% ratio (TEA ratio) 
	-


	o 
	o 
	o 
	May indicate over-estimation of value. 

	o 
	o 
	See FSM 2422.1 



	• 
	• 
	• 
	Notable fraction of the sales in the data base have excessive bid premiums ---TEA ratio consistently falls below 70%. 

	o 
	o 
	o 
	May indicate under-estimation of value 

	o 
	o 
	See FSM 2422.1 



	• 
	• 
	• 
	High number of no-bids 

	o May indicate over-estimation of value 
	•
	•
	•
	•

	Canvass purchasers 

	•
	•
	•

	Consider sale conditions – did the appraisal accurately reflect them 



	• 
	• 
	• 
	Erratic sale results 

	o 
	o 
	o 
	o 
	Winning bids for apparently similar sales quite varied 

	•
	•
	•
	•

	May indicate appraisals do not account for sale conditions in all cases, thus not estimating fair market value correctly 

	•
	•
	•

	May indicate that market conditions at time of sale are not being properly reflected 

	•
	•
	•

	Sales described in the bullet statements above may be skewing Base Period Price estimates 



	o 
	o 
	Possibility of collusion among bidders 




	Consistent set of bidders with a predictable pattern of bidding 
	•





